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This user manual is the copyright and intellectual property right of Sonardyne International Limited
(“Sonardyne”) and is provided solely for the customer’s use of the Sonardyne equipment as
described in this user manual and in accordance with Sonardyne’s then prevailing terms and
conditions of sale. This user manual has been compiled to the best of Sonardyne’s knowledge and
belief, but no representation, warranty (whether express or implied) or guarantee is made to any
persons or legal entities as to the accuracy, reliability or completeness of the information contained
in this user manual.

This user manual contains the proprietary, confidential information of Sonardyne and other third
parties and as such may not be used, disclosed or placed in the public domain (by whatever means)
by the customer except expressly in accordance with and subject to the above referenced terms
and conditions of sale.

The copyright and any and all intellectual property rights of any and all third parties which may be
referenced in this user manual or which may have provided proprietary products and/or software
and/or documentation (in whatever format) to Sonardyne in respect of the Sonardyne equipment as
described in this user manual are hereby duly acknowledged. The provision of any and all such
products and/or software and/or documentation by Sonardyne shall be subject to and in accordance
with the relevant third parties’ terms and conditions or the Sonardyne then prevailing conditions of
sale, as appropriate.

The Sonardyne equipment described in this user manual is protected by various UK and US Patents
and other patents internationally and registered trademarks of Sonardyne International Limited.

© Sonardyne International Limited 2015. All rights reserved.
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Contacting the Sonardyne Support Team
24-hour Emergency Telephone Helpline: +44 (0) 1252 877600

The Sonardyne 24-hour helpline is answered at the UK Headquarters during normal office hours
(08:00 to 17:00). Outside these hours, your call is automatically transferred to an agency, which logs
the details of your emergency and alerts the appropriate Sonardyne personnel.

Our aim is to make sure emergency requests are dealt with immediately during office hours, and are
responded to within 30 minutes at all other times.

Please note the helpline is for emergency use only.

If you require non-emergency product support, please contact your nearest Sonardyne office.
Alternatively, contact the Sonardyne Head Office:

Sonardyne International Ltd
Blackbushe Business Park
Yateley

Hampshire

GU46 6GD

United Kingdom

Telephone: +44 (0) 1252 872288
Fax: +44 (0) 1252 876100
Email: support@sonardyne.com

Note

Email and telephone support is available during normal UK office hours (08:00 to 17:00).
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Section 1 — Introduction

1.1 Introduction

This User Manual describes the safe installation, operation maintenance of the SPRINT System,
with Sonardyne Transceivers and Beacons. The information and procedures within this manual are
based on Sonardyne’s experience and knowledge.

To make sure the safety of the installer and operator is maintained, it is important that all Warnings,
Cautions and Safety Section in this manual, and the Warnings, Cautions and Safety Section of any
additional manuals are read and understood.

1.2 Related Publications

To make sure the equipment is operated safely, a Sonardyne Safety Manual is supplied with this
user manual. It is important that the Sonardyne Safety Manual is read and fully understood before
proceeding with any activity on the equipment.

Table 1-1 Related Publications

Publication Title

Sonardyne Safety Manual | Operational and Safety Precautions

UM-8084-101 Lodestar Hardware Manual
UM-8084-107 Lodestar AHRS Manual
UM-8025 Fusion User Manual
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Section 2 — Safety

2.1 Introduction

Before any activity is carried out on the equipment, it is recommended that the included Sonardyne
Safety Manual and all warnings and cautions in this manual are read and fully understood.

It is recommended the operator complies with the Health and Safety Regulations applicable to the
vessel and the region before operating this equipment.

Operators and service personnel must be familiar with the normal operating and safety procedures
for subsea equipment.

Documentation must be consulted whenever a or warning symbol is found on the
equipment, in order to determine the nature of the potential hazard and any actions which must be
taken.

If any additional equipment is used, any warnings and cautions in the equipment user manual must
be read and fully understood.

If the equipment is used in a manner not specified by the manufacturer, the protection provided by
the equipment may be impaired.

The safety of any system incorporating this equipment is the responsibility of the assembler of the
system.

2.2 Safety Procedures

Before carrying out any procedure on the equipment, make sure that all of the following warnings
and cautions are read and fully understood.

2.2.1 Warnings

Personal protection. Appropriate protective equipment such as protective footwear, hard hat
and gloves must be worn when handling or carrying out any procedures involving Sonardyne and
other equipment.

Heavy equipment. Many Sonardyne products and equipment types, such as transponders,
transceivers, cable drums etc. require Manual Handling Equipment (MHE) for lifting due to their heavy
weight. If MHE is not available, it is the responsibility of the operator to perform a manual handling
risk assessment prior to carrying out manual lifting/handling. Refer to the individual equipment
documentation for weight specifications.

Electric Shock Risk. Make sure the equipment is earthed before using.

Electric Shock Risk. Disconnect power from the equipment before removing the covers.

2.2.2 Cautions

Incorrect Power Supply. Make sure the Lodestar is supplied with 24 or 48 V DC only. Do not use
an AC power supply.
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Section 3 — Technical Description

3.1 Introduction

Subsea Precision Reference Inertial Navigation Technology (SPRINT) is an acoustically aided
inertial navigation system for subsea vehicles. The system extends the operating limits of Ultra-
Short Baseline (USBL) and can dramatically improve the operational efficiency of Long Baseline
(LBL) by using sparse arrays. SPRINT makes optimal use of acoustic aiding data from acoustic
positioning and other sensors such as Doppler velocity log (DVL) and pressure sensors. This
improves position accuracy, precision and integrity in any water depth while reducing operational
time and vessel costs.

3.2 Lodestar

The core of the system is the Lodestar platform. Lodestar was released to the market in 2007 as a
premium quality, survey grade, Attitude and Heading Reference System (AHRS) for surface and
subsea applications. Using the same hardware platform, Lodestar is fundamental to SPRINT.

Lodestar makes use of three ring laser gyroscopes that measure the angular rate and three
accelerometers that measure the specific force of a moving platform. The highest quality dual use
(commercial and military) field proven sensors have been selected for use due to their performance,
low mean time between failure (MTBF) and ease of export. These sensors have highly stable error
characteristics and are compensated for temperature variation making them ideally suited to subsea
applications.

3.3 Inertial Navigation

The Internal Navigation System (INS) sensor outputs are combined mathematically to compute the
position, velocity and attitude of the vehicle. The output is extremely low noise and very accurate in
the short term but slowly degrades over time. Therefore it is necessary to seamlessly aid the INS
with complimentary acoustic positioning and other aiding sources.

Acoustic Aiding with Sonardyne’s latest Sixth Generation (6G®) vessel-based transceivers and
subsea beacons maximise the benefits of the system by providing the most precise and reliable
acoustic aiding input.

Depending on the functionality level of the SPRINT system being used, various aiding options will
be available, whilst others may be disabled:

e USBL

e DVL

e Pressure Depth

e External Position

e Zero Velocity (ZUPT)
e LBL

3.3.1 USBL Aiding

The vessel-mounted USBL transceiver determines the range and bearing to an acoustic beacon
fitted to the subsea vehicle. Using vessel DGPS for position and VRU/MRU/AHRS for vessel motion
compensation, an absolute position for the vehicle mounted beacon is calculated by the USBL
system.
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This position is fed into SPRINT as an absolute positioning aiding input. Additionally, the USBL
system is synchronised to Coordinated Universal Time (UTC) to provide an accurate timestamp.
Whilst the use of Sonardyne USBL provides a tighter acoustic / inertial integration and the best
possible USBL positioning performance, SPRINT can accept position aiding from any USBL system
that uses correct time-stamped positions in an industry standard telegram. Although SPRINT
improves USBL system precision and short term accuracy, it will not resolve any inherent
systematic errors that are present. Users must therefore make sure the USBL system they are using
is correctly calibrated and recommended operating practices are observed, for example, using
regular sound velocity profiles.

3.3.2 Sparse LBL Aiding

In Sparse LBL operations, two or more (instead of four or five) beacons are deployed on the seabed
and their positions derived using ‘box-in’ or other top-down calibration techniques. With a known
beacon position, the INS can navigate in Sparse LBL mode using the ranges from one or more
seabed deployed beacon to acoustically aid the INS and constrain error growth in the absolute
position output. In this configuration, the vehicle mounted LBL transceiver (ROVNav 6)
communications will be routed to the vessel via the Lodestar for optimal time stamping of acoustic
range data.

3.3.3 ZUPT (Zero Velocity) Aiding

In certain operational situations the subsea vehicle will be static (e.g. during average position fixes).
In these situations, particularly if there is risk of loss of other aiding, it is beneficial to be able to aid
the INS with ‘zero velocity’ updates to estimate inertial sensor errors. This feature is available in
SPRINT and is easily activated from the main user interface.

3.3.4 Vehicle-Mounted Sensor Aiding

Lodestar has the ability to use vehicle-mounted aiding sensors such as Doppler velocity logs (DVL)
and pressure/depth sensors. The use of these sensors provides further benefits for subsea
navigation such as the ability to provide precise and continuous navigation output even if external
acoustic positioning is lost for periods of time. SPRINT does not need to be physically co-located
with the Doppler Velocity Log or integrated into the same housing. Only ‘coarse’ alignments and
offsets from the INS to the DVL are needed from the user. Fine offsets and misalignments are then
calculated in the field using a calibration routine. This approach allows for more flexible mounting
configurations to be considered.

3.4 Theory of Operation

3.4.1 Inertial Navigation

Inertial navigation is the computation of velocity, position and orientation from measurements of
acceleration and rotation.

Acceleration (velocity change) is measured by an orthogonal triad of accelerometers. Rotation
(angular change) is measured by an equally orthogonal triad of gyroscopes (see Section 3.4.2). The
composite mechanical structure is called the Inertial Sensor Assembly (ISA). An Inertial
Measurement Unit (IMU) is composed of the ISA and a processor that performs various forms of
compensation using e.g. factory calibration coefficients. The outputs of an IMU are compensated
delta angles and delta velocities typically at a rate of 100-200Hz.

Inertial navigation is based on the dead-reckoning principle. INS velocity is computed from an initial
value by integration (see Figure 3-1) of acceleration over time. Similarly, position is computed from
velocity and orientation (attitude and heading) is computed from integration of measured rotation
(angular change).
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Figure 3-1 Computation of Velocity via integration of Acceleration (1D example)**

It can be imagined how a fixed error (bias) in acceleration when integrated will cause an error in
velocity that grows proportionally with time giving rise to quadratic with time error in position.

This simplified description of the inertial navigation process match fairly well in the short term
especially for stable platform INS where the accelerometers were physically pointed in fixed
directions (e.g. North, East and Down). In practise, the 3D vector mathematics are somewhat more
involved, especially for modern strap-down INS where the sensors are strapped onto the vehicle
body.

** VVelocity at time ‘t’ is the sum of the areas under the acceleration curve (yellow counts as
negative) plus the initial velocity at time tO.
3.4.2 Inertial Sensors

3.4.2.1 Accelerometer

Most accelerometers used for inertial navigation are of the force-feedback pendulous type illustrated
in Figure 3-2. A proof mass at the end of a pivoted or flexible arm is balanced via feedback control
keeping its deflection close to zero. The coil current generating the counter acting force is a
measure of acceleration along the single axis of free movement.

Figure 3-2 Force Feedback Pendulous Accelerometer
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It is impossible to distinguish between true kinematic acceleration (velocity change relative to the
Earth) and gravity. A stationary accelerometer with its sensitive axis pointed up will measure +1g
even though it is obviously not moving anywhere. The term specific force is the sum of kinematic
acceleration and gravity and has been coined to express what an accelerometer really measures.

3.4.2.2 Gyroscope

Modern gyroscopes are based on a variety of different physical principles. Most navigation grade
gyroscopes are currently based on optics using the “Sagnac” effect to sense rotation, e.g. the Ring
Laser Gyro (RLG, see Figure 3-3):

Laser beams are made to travel in both opposite directions within a cavity (“ring”) formed by
typically 3 or 4 mirrors. When the cavity rotates relative to inertial space one beam has to travel
further than the other. A part of the laser light is allowed to escape via a semi-transparent mirror and
is used to form a fringe pattern. Optical sensors count the direction and number of fringes passed
which is a precise (digital) measure of how much RLG has rotated relative to inertial space.

In a Fibre Optic Gyroscope (FOG) light travels through loops of optic fibre rather than a closed path.
Both RLG’s and FOG'’s can achieve very high performance.

Other commonly used gyro technologies are:
e Conventional spinning metal gyroscope
o “Dynamically Tuned Gyro” (DTG). Ingenious compact mechanical strap down device.

o Hemispherical Resonator Gyro (HRG). Resonant device made of very high Q quartz
("Wine glass”) — Coriolis force device

e  Micro Electro-Mechanical Devices (MEMS) based gyros (Coriolis force)
Figure 3-3 Ring Laser Gyroscope Principle of Operation

3.4.3 Strap-down Inertial Navigation

The process of strap-down inertial navigation is shown in Figure 3-4. Vehicle orientation relative to
the Earth is maintained within the navigation computer via integration of measurements from the
gyroscope triad and is compensated for Earth rotation and vehicle motion over the surface of the
Earth. Known orientation is used to transform accelerometer specific force into a navigation frame
(often North-East-Down — NED).
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Specific force is compensated for gravity and Coriolis force to obtain kinematic acceleration. Gravity
is computed using a mathematical model and is dependent on vehicle position on the Earth, most
importantly latitude and depth/height. Coriolis force is a “mathematical artefact” that arises and
requires compensations because the navigation frame rotate with the Earth and is therefore not a
true inertial frame (fixed relative to the stars). Finally, acceleration is integrated to obtain velocity
and velocity is integrated into position.

Typically the strap-down computations are set to execute at 100-200 Hz whereas the inertial
sensors may be sampled at several kHz. The raw rate is reduced using a coning and sculling
algorithm that e.g. very precisely takes into account the non-commutativity of rotations (sequence of
rotations matter).

Figure 3-4 “Strap-Down” Inertial Navigation

3.4.4 Errors in Inertial Navigation

The sources and error propagations in inertial navigation are complex and not always intuitive. The
initial part of Section 3.4.1 describes how a constant error in acceleration would cause error in
position to grow with time squared. In a real INS with external aiding (as described in Section 3.4.7)
a fixed accelerometer bias would primarily cause an error in roll/pitch which would make gravity
couple into the horizontal plane by just enough to counteract the position drift.

Simulation technigues and tools are available for accurately predicting INS performance in various
scenarios and taking all significant error sources into account. Somewhat counter intuitively,
gyroscope errors in general play a more significant role than accelerometer errors.

3.45 Reference frames

A number of reference frames are used within inertial navigation.

3.4.5.1 Vehicle frame

Axes are along the vehicle axis, typically forward, starboard and down. The vehicle frame is typically
used for navigation outputs (e.qg. roll, pitch and heading) and for defining various sensor lever arms
(“offsets”) and mounting angles.
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3.4.5.2 IMU frame

Axes are along the inertial sensor axes as typically marked on the IMU/INS housing. IMU frame is
used for many INS internal computations.

3.4.5.3 Navigation frame

Frame used for the inertial navigation computation of position and velocity (most often local level
e.g. North, East and Down).

3.4.5.4 Inertial frame
Non-rotating frame (relative to inertial space).

Note

Definitions of SPRINT (and Lodestar) specific reference frames are provided in Appendix A and
Appendix B.

3.4.6 Gyrocompassing — North Finding

An INS can determine its orientation (roll, pitch and heading) relative to the Earth by
“gyrocompassing”. Basically the direction of up/down and the Earth spin axis can be sensed using
the inertial sensors.

For a slow moving (i.e. marine) vehicle, the measured acceleration (specific force) vector will point
“up”, i.e. the measured vector will be parallel with the local gravity vector (down). In practise,
measured acceleration is averaged (filtered) to cancel out effect of vehicle motion.

The local gravity vector will follow the rotation of Earth relative to inertial space, see Figure 3-5. The
direction of East can be determined by tracking the systematic change in the direction of the gravity
vector relative to inertial space over time. Knowing the direction of down and East allows the
direction of North and full orientation to be determined.

Figure 3-5 Earth Rotation
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The Earth rotates by just 15 deg/hour and the gyroscopes used for tracking the change of direction
of gravity must be accurate to considerably better values. Furthermore, it can be shown that the
local gravity vector direction changes only by the cosine of Latitude part of Earth rotation, i.e.
change is reduced towards the Poles. This explains why heading accuracy is typically specified as
X.Xxx degrees * Secant Lat (secant = 1/ cosine).

Vehicle position change in the N/E direction (from, e.g. steaming) will cause the gravity vector to
change in this direction also and not be pure E/W. This will bias the gyro-compassing determined
heading if not compensated for by e.g. measurements from a GPS receiver.

An inertial based Attitude and Heading Reference System use the described principles to generate
robust roll, pitch and heading.

3.4.7 Aided INS

The drift of a typical commercial airplane inertial system is on the order of INMPH (Nautical Mile
Per Hour). This is adequate for guidance from one airport to another and e.g. crossing the Atlantic
but hardly useful for navigation of slow moving marine vehicles intended to do e.g. seabed mapping.

Improved performance can be achieved by Aiding the INS with measurements from one or more
external sensors; see Figure 3-6. IMU data feeds into two separate algorithms: AHRS and AINS.
The AHRS is used as a convenience for providing the AINS with initial estimates of attitude/heading
thereby simplifying its design.

The INS block was described in Section 3.4.3 and provides the position, orientation and velocity
output. The role of the error state Kalman filter is to estimate and compensate errors in the inertial
navigation and thereby constantly keep the INS on track, while monitoring the correction feed.

The Kalman filter determines INS errors from external sensor measurements. The difference
between a measurement (observation) and its expected value (based on the INS) is fed into the
Kalman filter and is used to refine its state vector and covariance matrix. The state vector is
composed of INS errors in position, orientation and velocity and often also key inertial sensor errors
such as gyroscope and accelerometer bias. Errors in external sensors can also be modelled for
improved performance.

The covariance matrix is the “memory” of the Kalman filter and it holds the uncertainty of each state
and the correlation between states. Useful performance metrics such as expected positioning
accuracy is extracted directly from the covariance matrix.

The Kalman filter will manage asynchronous data and the considerable latency often found in
acoustic observations. An Aided INS is often referred to as a “hybrid inertial system”.

The combination of a DVL and INS provides accurate heading/attitude and the ability to perform
dead-reckoning to an accuracy of just a few meters per hour. This functionality is extremely useful
for subsea navigation. Further combination with USBL or (sparse) LBL provides absolute positioning
that is considerably more accurate and robust than acoustic positioning by itself.
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Figure 3-6 Sonardyne “Lodestar” Acoustically Aided INS functional block diagram

The INS aiding options available in SPRINT are listed in Table 3-1. Only certain position aiding
inputs, such as USBL can be used to initialise Inertial Navigation and that these aiding inputs must
be UTC time synchronised.

Table 3-1 SPRINT INS Aiding Options

Aiding Source Aiding Type Aiding Considerations

E\%Sig';n Velocity Depth Aiding | Time Sync tctt)al?wilt)igligseed

g . N

(Horizontal) Aiding (Vertical) Required” INS?
USBL v x v v v
LBL v x x x x
External Position v x v v v
DVL x v x x x
Zero Velocity x v x x x
Pressure Depth x x x x
External Depth x x v x x

Note

Please note and follow the operational considerations provided below:
*LBL aiding must be used in conjunction with DVL Aiding.
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3.5 System Architecture

3.5.1 Architecture

The architecture of the SPRINT system is shown in Figure 3-7.
Figure 3-7 Logical SPRINT Architecture

The Navigation PC runs the SPRINT software which comprises two components:

o User Interface, which provides configuration, control and monitoring of the Lodestar and
SPRINT system.

e SPRINT Server, which routes all communications between the Lodestar, User Interface
and any other topside external devices. The SPRINT server also logs all data from the
Lodestar on the Navigation PC, including raw sensor feeds.

The Lodestar Communications Hub (LCH) is a serial device server and Ethernet hub used by the
Navigation PC. An Ethernet link is provided between the Navigation PC and the LCH (ports). For
this reason IP Addresses and Ports are used to specify serial as well as Ethernet devices connected
to the LCH. The IP addresses of each of the main system components are shown above but note
that the Lodestar IP address will only be used if the Lodestar is to be connected to the topside
components using an Ethernet connection.

External devices may be connected directly to the Lodestar as well as to the LCH.

The SPRINT system stores the configuration of the Lodestar and Software/Server. A Factory
(default) Configuration is provided as a starting point for setup. Thereafter a User Configuration is
stored by the software every time a configuration change is made or by user request. If the Lodestar
used by the SPRINT system is swapped, the software will prompt the user to re-apply the User
Configuration to the new Lodestar to continue operation as before.

Section 3 — Technical Description 11
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As well as storing the log files in real time on the Navigation PC, the Lodestar also stores a rolling
backup of all the log files on its onboard SD card. The size of the log data is variable depending on
the number/update rate of aiding sensors and also the number of outputs specified. Typically for a
USBL/DVL/Depth aided system, the log files are populated at the rate of 0.5mb per minute, which
will provide over 10 days continuous onboard storage. The log files on the Lodestar SD card can be
retrieved offline using the Lodestar PC Utility (refer to UM-8084-107 “Lodestar AHRS Manual” for
instructions).
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Section 4 — Planning

4.1 Navigation Scenario

Navigation Scenario

Interface*

Construction Dynamic
Lodestar Connection Either:
Ethernet (100mbit only) 4 v
Serial RS232 115,200 baud v v
Time Synchronisation** Either:
GPZDA UTC message with configurable latency to 1 PPS v x
GPZDA UTC message & 1PPS sent to Lodestar v v
USBL Aiding*** Either:
PSIMSSB message (UTC time, WGS 84 Lat/Long Radians) v v
USBL GGA message (UTC time, WGS 84 Lat/Long Degrees) v v
Sonardyne External Position (UTC time, WGS 84 Lat/Long Degrees) | v v
DVL Aiding**** Either:
RDI Binary PD4/5 Message (Recommended) v v
RDI Binary PDO Message 4 4
Pressure Depth Aiding One Of:
DigiQuartz kPA/PSI/Metres v v
Valeport Midas SVX2 v v
NMEA DPT message 4 x
Sonardyne SONDEP message v x
Tritech Winson (processed) message) v x
Sonardyne External Depth v 4
LBL Aiding
Fusion 6G LBL 1.11.04 (or later) with appropriate dongle v v
INS Position Output (with UTC timestamp) Either:
From SPRINT topside (LCH) 4 v
From Lodestar (ROV) v v
AHRS Attitude Output (No UTC timestamp) Either
From SPRINT topside (LCH) v x
From Lodestar (ROV) 4 v

Prior to installation it is important to consider the navigation scenario to determine the optimum
system configuration and interfaces. Typically the scenario is defined by the positioning (or attitude)
accuracy specifications of a mission or project but equally important is the timeliness (or latency) of

positioning or attitude provided by SPRINT system.

Section 4 — Planning
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Two common navigation scenarios are explained below. The recommended configuration for each
navigation scenario is explained in the installation and configuration sections. If there is uncertainty
as to which scenario is to be supported it is recommended that ‘Dynamic Survey’ is selected.

4.1.1 Construction Survey

In this scenario the SPRINT ROV will be used to position subsea structures or pipelines that are
slow moving. The positioning and attitude accuracy tolerances can be high but the timeliness
requirements of the outputs is relatively low, typically less than 0.5 seconds, as the ROV is often
moving very slowly or performing static fixes during critical positioning phases.

4.1.2 Dynamic Survey

In this scenario the SPRINT ROV will be used to perform dynamic, high accuracy surveys such as
multibeam pipeline out-of-straightness. The positioning and attitude accuracy tolerances are high
and so is the timeliness of the outputs as the ROV motion must be compensated correctly when
processing multibeam data. Any significant latency in ROV position or attitude will result in errors or
artefacts in the final multibeam terrain model. In this scenario accurate alignment and instrument
offsets will be more critical than in the ‘construction’ survey.

4.2 Interfaces

Prior to installation the following interfaces should be planned according to the SPRINT navigation
scenario (¥indicates a supported interface, “%” indicates a non-supported interface):

Notes

*See Appendix E for all message formats.

** |t is assumed that in either mode of time synchronisation that the GPZDA message is received no
faster than 1Hz (once a second) otherwise the system may not be able to synchronise.

*** All USBL aiding inputs must be raw / measured and should not be subject to any filtering.
**xx See Appendix D for supported DVL configurations.
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4.3 Connections

To guarantee the successful operation of the SPRINT system, the system connectivity must be
considered at the installation planning stage. A suggested system connectivity diagram for the
‘construction survey’ configuration is shown in Figure 4-1.

Figure 4-1 Construction Survey Interface Diagram
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A suggested system connectivity diagram for the ‘dynamic survey’ configuration is shown in
Figure 4-2.

Figure 4-2 Dynamic Survey Interface Diagram
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4.4 Cabling

The system cabling must be carefully planned prior to installation to avoid issues. Subsea cables
can be costly and time consuming to correct or replace during the installation phase.

4.4.1 Topside

The majority of topside interfaces will be serial. Consideration should be given for any serial cable
run length, as this could lead to data corruption if the length exceeds RS232/485 limits, particularly
the serial connection between the SPRINT LCH and the Lodestar (if used). If the distance between
the SPRINT LCH and the ROV (de) multiplexer is excessive for an 115,200 baud rate RS232 serial
link then alternate interfaces should be planned to make sure the data is not corrupted, such as
Serial to Ethernet or RS232 to RS422/485 converters. Alternatively an Ethernet connection to the
Lodestar could be considered.

442 Subsea

A typical cabling diagram for all the required subsea connections to and from the Lodestar on the
vehicle is provided in Appendix F. This diagram should be used to produce vehicle and sensor
specific SPRINT cables prior to installation. If required, there are also individual cable pin-outs for
each specific Lodestar port available in the Lodestar Hardware Manual UM-8084-101.

4.5 Time Synchronisation

The SPRINT Lodestar will be time synchronised to UTC by receiving a ZDA message and optionally
a 1PPS timing pulse from a GNSS receiver. The SPRINT system will be interfaced to other
systems, such as USBL, Survey Software or Multi-beam that are also time synchronised to UTC
using connections to GNSS receivers. A common source of perceived INS position error is
inconsistent time synchronisation across the various systems interfaced with the SPRINT system.

There are three fundamentally different types of GNSS ZDA/1PPS time synchronisation:
e ZDA arrives before its associated 1PPS
e ZDA arrives after its associated 1PPS (most common)
e 1PPS and ZDA are asynchronous (seen with many modern GNSS systems)

Different models and configurations of GNSS receiver may use any of the three types listed above.

It is very important that the type of synchronisation used by each GNSS receiver is understood prior
to SPRINT installation to avoid timing issues. This may require consultation with the GNSS
manufacturer. If possible, the use of a common GNSS receiver for time synchronising all systems
will greatly reduce the risk of issues.

4.6 Depth

The SPRINT system supports either pressure or depth aiding input to determine the depth of the
INS. There are several factors that should be considered during the planning phase.

4.6.1 Pressure to Depth Conversion

In the case of a pressure aiding input the Lodestar performs a simple pressure to depth (metres)
conversion. The pressure to depth conversion scale factors are provided in Appendix G.
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If there is a requirement for a different pressure to depth conversion calculation to be used, the
operator can either:

o Convert the pressure sensor data to metres using the required conversion and pass this
to the Lodestar as a depth (m) aiding message.

o Apply a pressure depth offset to the SPRINT system at operating depth so the INS
depth is consistent with the intended depth datum.

e Convert the INS depth output from the system to another datum using the provided
conversion calculations.

4.6.2 Surface Pressure

Most pressure sensors will measure ambient air pressure at the surface. This is the equivalent of
approximately 10 metres of water depth. SPRINT allows the operator to measure the surface
pressure on deck and remove it from any subsequent depth calculation. Depending on project
requirements surface pressure may be removed as described above or the INS depth could also
include surface pressure — this should be decided at the planning strange.

4.6.3 LBL References

Whichever method or configuration of SPRINT pressure depth is used, the INS depth should always
be consistent and relatively accurate to any LBL reference depths.

4.7 (Sparse) LBL Array Planning

4.7.1 Features and Operational Guidelines

The INS can be aided by LBL range observations from a Fusion 6G system.

Due to its DVL-inertial dead-reckoning capability, the INS can manage with less than the 4 or 5
beacons traditionally required for acoustic LBL tracking, hence the term ‘Sparse’ LBL.

Please consider the following features and operational guidelines for sparse LBL:

e The minimum number of beacons at one site is two. Use of three beacons will support
loss of acoustics to any single beacon and INS integrity if there is an error with aiding
from any single beacon. For this reason the recommended number of beacons for a
sparse array is three.

e In specific scenarios with favourable vehicle dynamics / trajectory the INS can be aided
with range observations from just a single beacon. Additional operational guidelines
should be considered — contact Sonardyne for advice.

e The INS can be actively aided by up to 6 beacons but can record LBL aiding
observations for up to 10 beacons for analysis and post processing.

e Acoustic update rate to each beacon should be faster than 10 seconds — this is primarily
for screening of observations prior to INS use.

e Pressure depth provided to the INS and beacon depths should be consistent. Relative
depth errors will cause error in INS positioning if line of sight is not horizontal.

e Sound velocity in Fusion must be correct. Make regular updates if change is expected (>
0.5 m/s).

e LBL (range) aiding must be used in conjunction with DVL aiding, particularly in very
sparse arrays. Contact Sonardyne for specific guidance if DVL is not available.
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e Make sure placement of LBL aiding beacons provides adequate acoustic line of sight
and good geometry to the LBL transceiver during planned operations.

4.7.2 Sparse Array Geometry

The reference beacons in the sparse array should be placed so the line of sight to at least two of the
beacons is approximately orthogonal to reduce the error in opposing directions.

An example of good geometry is shown below in Figure 4-3 and examples of poor array geometry
are shown below in Figure 4-4.

Figure 4-3 Example of Good Sparse Array Geometry

Figure 4-4 Examples of Poor Sparse Array Geometry

4.7.3 First Use of ‘Sparse’ LBL Aided INS

It is recommended that with first use of ‘Sparse LBL Aiding’, full LBL array navigation is also
available to provide an independent position reference. Refer to the procedure detailed below:

1. Deploy a full LBL array.
2. Run full LBL acoustic tracking in Fusion.

3. Use SPRINT with LBL aiding from two or more of the array beacons (depending on
operational requirements).

4. Compare the positioning performance of SPRINT sparse LBL against full acoustic LBL.

Gross difference between the two positions will indicate an issue for investigation/resolution; see
Section 12.9 for troubleshooting advice.
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4.8 Check List

Use the list below to assist in making sure the planning for the SPRINT system is complete prior to
system installation:

No Action Manual Checked
Section

1 Plan navigation scenario 4.1

2 Plan (and prepare) required interfaces 4.2

3 Plan system connections 4.3

4 Plan system cabling 4.4

5 Plan system time synchronisation 4.5

6 Plan system depth 4.6

7 Plan sparse LBL array(s) if required 4.7

Sign Date
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Section 5 — Installation

Before installing the equipment, make sure Section 2 — Safety is read and fully understood.

5.1 SPRINT System Kit

The SPRINT system kit should comprise the following items:
Figure 5-1 SPRINT Installation Kit

@ Lodestar (¢) Lodestar Cable Tails
@) Navigation PC © Lodestar Test Cables
€ Lodestar Communications Hub (LCH) (® Lodestar Mounting Plate (not shown)

5.2 Mounting Lodestar

The Lodestar should be installed on the vehicle as per the instructions below.

Notes
It is not necessary to mount the Lodestar at the vehicle centre of rotation/gravity.

The Lodestar should be mounted very securely to the vehicle in a rigid location. It should not be
mounted on a moveable tray or in locations with excessive mechanical noise (e.g. directly next to
hydraulic pumps)
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The default mounting for the Lodestar is in the vertical position (refer to Figure 5-2).

Figure 5-2 Lodestar Nominal Mounting

In this arrangement the X-axis indicator on the top of the Lodestar is aligned with the forward
direction of the vehicle reference frame and the Y-axis indicator is aligned with the starboard
direction of the vehicle reference frame (refer to Figure 5-3).

Figure 5-3 Lodestar Axis Indicators
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A mounting plate is supplied with the SPRINT system kit to support the mounting arrangement.

The Lodestar can also be mounted in other orientations if required. A common alternative mounting
is with the Lodestar orientated horizontally as shown below in Figure 5-4.

Figure 5-4 Lodestar Horizontal Mounting

The standard SPRINT system kit does not include mounting brackets or plates to support this
orientation but optional mounting brackets can be ordered from Sonardyne on request. Please
contact Sonardyne Support for further details.

Additional Lodestar power, maintenance and installation guidelines are provided in the Lodestar
Hardware Manual UM-8084-101.

5.2.1 Alignment

For the Lodestar and SPRINT system to provide accurate attitude and positions with respect to the
vehicles reference frame, any misalignment between the Lodestar and vehicle reference frame must
be corrected by determining and applying Lodestar mounting angles in the SPRINT system. A
definition for the Lodestar reference frame including mounting angle convention is described in
Appendix B. Typically there are two stages in determining the Lodestar Mounting angles.

First determine the initial ‘coarse’ mounting angles. If the Lodestar mounting is at the default as
described in Section 5.2 then the Lodestar mounting angles will all be zero. If the Lodestar mounting
is non-default (e.g. the Lodestar is mounted horizontally) then the mounting angles must be applied
in the SPRINT system. A selection of Lodestar mounting orientations and related mounting angles
are provided in Appendix C.

Once the (coarse) mounting angles of the Lodestar have been determined using the guidance
provided above, the angles can be refined using existing methods for ‘Gyro to ROV’ calibration.

These methods may include:

e Manual calculation using traditional survey methods such as a dimensional control
survey (usually performed in a static environment onshore).

e Automated calculation provided by Survey software using comparison of ROV gyro
against vessel reference gyro (can be performed offshore in a dynamic environment).

Make sure the results of any additional mounting angle calculation match the conventions listed in
Appendix B before they are applied to the SPRINT system.
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5.3 Mounting Aiding Sensors

All aiding sensors must be mounted very securely to the vehicle in a rigid location. They should not
be mounted on moveable arms or trays as this may seriously degrade SPRINT performance by
providing inaccurate or imprecise aiding data.

5.3.1 Doppler Velocity Log (DVL)

The SPRINT system is provided with a software utility that will calculate the mounting angles of the
DVL used with the system. Therefore a variety of mounting angles can be supported but the
SPRINT default DVL configuration (see Appendix C) will assume the DVL is mounted with the
transducers facing towards the seabed and the alignment mark (also referred to as navigational
groove) aligned to the forward direction of the vehicle reference frame.

Figure 5-5 DVL Alignment

5.4 Measuring Lever Arms

Typically a vehicle has a central reference point or CRP and position calculations for a vehicle
should be made with respect to this point. SPRINT will automatically provide the INS position for the
defined vehicle CRP (and up to two additional remote positions if required).

The lever arms from the vehicle CRP to the Lodestar and any aiding sensors such as DVL,
Pressure Depth and USBL beacon must be measured.

Notes
One of the most common sources of error in INS positioning is incorrect lever arms.

It is recommended that all measurements are carried out by at least two (ideally three) individuals
and the results compared.

Lever arms must be measured to the point of reference on each aiding sensor. If the point of
reference is unknown, consult the relevant product manual.
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541 Lodestar Lever Arm

The Lodestar lever arms must be measured from the vehicle CRP to the Lodestar ‘centre of axis’'.
The location of the ‘centre of axis’ for each of the three subsea housing types is shown below (all

dimensions are in millimetres).
Figure 5-6 1000 m Lodestar Centre of Axis Location

Figure 5-7 3000 m Lodestar Centre of Axis Location

Figure 5-8 5000 m Lodestar Centre of Axis Location
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5.5 Connecting the Equipment

Before proceeding with any action make sure all Warnings and Cautions, and the Safety section in
this manual are read and fully understood. The equipment interfaces should have been defined as
described in Section 4.2 Interfaces. A full set of Lodestar test cables and cable tails are supplied
with the SPRINT system. It is assumed that vehicle and instrument specific interface cables have
already been made using guidance provided in Planning, Section 4.4.2 “Subsea”. Use the following
procedure to connect the equipment.

1. Refer to Figure 5-9. Connect the vehicle power cable to the Console Port (CP) connection (1
on the top of the Lodestar.

If a Pressure Depth Sensor is to be connected to the Lodestar, connect to Port C1 (2]

For Ethernet communications and/or a 1PPS pulse, connect the vehicle to the Lodestar
Port E1 ©.

4. If a Doppler Velocity Log is to be connected to the Lodestar, connect to Port T1 (4}

5. If an LBL Transceiver is to be connected to the Lodestar, connect to Port T2 6.

Figure 5-9 Lodestar Connection Points

@ Console Port (CP) @) Port(T1)
@) Port(C1) © Port(T2)
© Port(E1)
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6. Refer to Figure 5-10. Connect the Navigation PC O tothe LCH® using the Ethernet Cable
@ . A label on the Navigation PC will indicate which Ethernet port to use.

Figure 5-10 Connecting the Navigation PC to the LCH

@ Navigation PC © LCH
@) Ethernet Cable

7. Referto Figure 5-11. The Lodestar © can be connected to the LCH @ by two methods:

Note

If the Lodestar serial connection length exceeds RS232/484 limits, data may be corrupted, see
Section 4.4.1 for guidance.

e An Ethernet cable & connected to the Ethernet connection point 2 on the LCH and
connection C2 on the Lodestar.

e A serial port cable ©® connected to serial port 1 on the LCH and connection CP on the

Lodestar.
Figure 5-11 Connecting the Lodestar to the LCH
@ LCH € Serial Port Connection
@) Ethernet Cable connection @) Lodestar
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8. Referto Figure 5-12. Additional equipment can be connected to the serial points at the rear of
the LCH ©.

e Toadd a GPZDA feed @ from the vessel GPS, connect to serial port 3 @ on the LCH.

e To add a USBL position feed © from the vessel USBL system, connect to serial
port 4 © onthe LCH ©.

e To add a Pressure Depth (6 input to the topside, connect to serial port 5 © on the
LCcH ©.

e To add a 1PPS timing pulse from the vessel GPS, connect to 1PPS In Port @ on the
LCH. Then send the pulse to the Lodestar by connecting to 1PPS Out Port (3}

Figure 5-12 Adding Additional Equipment to the LCH

@ LCH () GPZDA feed @) Serial Port 3
@ 1PPSIn Port © USBL position feed € Serial Port 4
€ 1PPSOutPort (> Pressure Depth Input ¢ Serial Port5

5.6 SPRINT Software

The Navigation PC is supplied pre-installed with SPRINT software; if the software is not installed
instructions for installation and updates are supplied below:

1. Log into the PC Administrator user account.

2. Insert the SPRINT software CD into the CD drive of the Navigation PC.
3. Navigate to and run Setup.EXE from the CD drive.

4. Follow the instructions provided by the software installation tool.

5.7 Lodestar Firmware

The Lodestar supplied with the SPRINT system will be pre-configured with the correct firmware for
operation with the SPRINT system. Refer to UM-8084-101 “Lodestar Hardware Manual” for detailed
instructions on the method for firmware upgrade. If you are unsure if your Lodestar is running the
correct firmware version for use with SPRINT contact Sonardyne Support.
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5.8 Check List

Use the list below to assist in the system installation, prior to the configuration:

No Action Manual Checked
Section

1 Check system kit contents 5.1

2 Install Lodestar 5.2

3 Determine equipment alignment 5.3

4 Measure instrument offsets 5.4

5 Connect equipment interfaces 5.5

Sign Date

Note

Refer to Appendix H for a full step-by-step installation and setup checklist that can be printed and
used as a hard copy reference
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Section 6 — Configuration

6.1 Changing the Lodestar Console Port (CP) Baud Rate

If the Lodestar is to be connected using a serial interface, the console port baud rate must be set at
115200. Lodestars shipped as part of a SPRINT system will be pre-configured with this baud rate. If
the Lodestar has not been pre-configured for this baud rate, the Lodestar PC utility software can be
used to configure the console port baud rate, refer to UM-8084-107 “Lodestar AHRS Manual” for
instructions.

6.2 Configuring Lodestar Communication Hub (LCH)

The LCH provides an 8-port serial device server interface for the SPRINT system.
Figure 6-1 LCH Front and Rear

The LCH can provide a variety of configurable serial settings for each serial input device or output
port required topside, such as:

e Baud rates from 50 to 921,600.
o RS-232, RS-422, RS-485 Half Duplex or RS-485 Full Duplex.
o Data bits, Stop bits, parity, flow control and FIFO.

The LCH also contains a 1PPS conditioner that can be used to condition and boost the 1PPS signal
before it is sent to the Lodestar.

The LCH is supplied pre-configured with the following settings for serial input/output interfaces:
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Table 6-1 Serial Input / Output Interfaces

LCH Local Purpose Baud Data |[Stop |Parity |FIFO Flow Interface
Port TCP Rate Bits |Bits Control
Port

Port1 | 5001 Lodestar 115200 8 1 None Enable | None RS-232
Console
Port

Port2 | 5002 GPS Input | 9600 8 1 None Enable | None RS-232

Port3 | 5003 ZDA Input 9600 8 1 None Enable | None RS-232

Port4 | 5004 USBL Input | 9600 8 1 None Enable | None RS-232

Port5 | 5005 Depth or 9600 8 1 None Enable | None RS-232
S.V. Input

Port6 | 5006 Primary 9600 8 1 None Enable | None RS-232
Output

Port 7 | 5007 Secondary | 9600 8 1 None Enable | None RS-232
Output

Port 8 | 5008 DO NOT
USE

If it is necessary to modify any setting for system operation, follow the procedure below:

Note

The LCH Port 1 is pre-configured to match the default serial connection configuration of
Lodestars used with SPRINT systems. If this Port needs to be modified, the default Lodestar
connection configuration will need to be changed. It is advised that Sonardyne Support are contacted
for further instructions.

It is necessary to know the IP address of the LCH unit. At the time of manufacture the IP address is
set to 192.168.179.51. The IP address can be discovered as follows:

1. Open NPort Administrator by navigating from the start menu: Programs > NPort
Administration Suite > NPort Administrator.

2. Click the Search button on the toolbar and wait 5 seconds for the search to complete. The
model and IP address of the LCH comms unit will appear.

Note

The LCH factory default IP address is 192.168.179.51.

Once the IP address is known, open Internet Explorer.

Enter the LCH IP address into the address bar e.g. http://192.168.179.51.

A web configuration page will be displayed.

To change any of the port settings, expand the Serial Settings item on the left hand pane.
Select the port to be configured; the current settings will be displayed on the right hand pane.
Change the settings as required and then click Submit to save the settings.

© © N o g bk~ w

Click Save/Restart and wait approximately 30 seconds for the changes to be applied and the
LCH to restart. The LCH will beep twice when it is ready.

10. When all changes have been made close Internet Explorer.
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6.3 SPRINT Software Configuration

Insert the security dongle into the Navigation PC then open the SPRINT software by double clicking
on the SPRINT application desktop icon:

6.3.1 SPRINT Security Dongle

The security dongle sets the SPRINT aiding options (S5 or S10 system).
The SPRINT S5 and S10 aiding options are shown in Figure 6-4 and Figure 6-5.

1. Refer to Figure 6-2. The dongle validity and date/time of expiry information is displayed within
the SPRINT information bar.

Figure 6-2 Dongle Info Bar

Auding Inputs
IJSEL LEL Depth

@ @ 0 0

IDDngIe: Yalid, , Dake)Time of Expiry: 29/10/2013 23:59:59 {LITC}I

2. Referto Figure 6-3. The SPRINT aiding options (S5 or S10) can be viewed by selecting Help
> About > Dongle Info from the SPRINT Menu bar.

Figure 6-3 Dongle information
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3. Referto Figure 6-4 and Figure 6-5. SPRINT aiding options for S5 and S10 systems are
displayed along with dongle validity, type of expiry and date/time of expiry.

Figure 6-4 SPRINT S5 Settings

m

The following is a summary of the features that are enabled in
this version of SPRINT. Please contact Sonardyne for information
regarding an upgrade.

Dongle | SPRINT

Dongle: Valid, Time unlimited
Type of Expiry: Never Expires
Date/Time of Expiry: n/a

Aiding Functions
USBL @ Metrology
LEL @ Enainsering
Depth

Doppler Velocity Log (DWL)

Zero Velocity Update (ZUPT)

External Position (XP0OS)

Zero Mean Depth (ZMD)

Figure 6-5 SPRINT S10 Settings

m

The following is a summary of the features that are enabled in
this version of SPRINT. Please contact Sonardyne for information
regarding an upgrade.

Dongle | SPRINT

Dongle: Valid, Time unlimited
Type of Expiry: Never Expires
Date/Time of Expiry: n/a

Aiding Functions
USBL @ Metrology
LEL @ Engineering
Depth

Doppler Velocity Log (DVL)

Zero Velocity Update (ZUPT)

External Position (XPOS)

Zero Mean Depth (ZMD)}
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6.3.2 Lodestar Connection

To connect the Lodestar to the SPRINT system, follow the instructions below:

1. If thisis the first time the software has been connected to the Lodestar or the connection is not
active, the connection window should automatically be displayed. If the connection window
does not appear, open it by selecting Configure > Lodestar > Connections.

2. Onthe Connection to Lodestar screen, click the Ethernet/LCH tab and enter the IP
Address and Port:

Refer to Figure 6-6. If the Lodestar is connected by means of a serial connection to the
LCH, enter IP Address: 192.168.179.51 and Port 5001.

Figure 6-6 Serial Connection to Lodestar

Cennection To Lodestar E
Ethemet / LCH Serial

IF Address: 152 168 175 51

Port: 5001

‘ Lodestar Hardware

Reset ‘ Connect H Close ‘

Refer to Figure 6-7. If the Lodestar is connected directly by means of an Ethernet
connection to the LCH, enter IP Address: 192.168.179.50 and Port 4000.

Figure 6-7 Ethernet Connection to Lodestar

Connection To Lodestar E
Ethemet / LCH Serial

IP Address: 157 168.179.50

Port: 4000

‘ Connect H Cloze ‘

Lodestar Hardware
Reset

3. Click Connect. If this is the first time the system has been run and connected to the Lodestar
it will then configure communications routing and ‘pipes’. It may take several minutes for this
process to complete; a progress indicator will be displayed.

Section 6 — Configuration 34



User Manual for SPRINT UM-8253

Issue A Rev 4

4. Once connected, the SPRINT software will check the settings of the Lodestar and may prompt
you for a stored configuration.

o If this is the first time the system has been run, you may be prompted to apply the
Factory (Default) Configuration.

e If the system has been run before but the Lodestar settings are different than the last
used (e.g. a different Lodestar is being used), you may be prompted to re-apply the User
Configuration.

5. Refer to Figure 6-8. If the Lodestar is not connected the software will prevent you accessing
any menu options to retrieve or configure Lodestar settings.

Figure 6-8 No Lodestar Connection for Configuration

View Tools Help
Lodestar
INS

Time Synch

Logging
Outputs

Options

6. In addition, the system status LEDs at the bottom of the main application window will indicate
that there is no Lodestar connection, as shown below.
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6.3.3 Lodestar Settings

To configure the Lodestar settings, proceed as follows:
1. Click Configure > Lodestar or right-click on the Lodestar/AHRS LED.

2. Refer to Figure 6-9. Enter a default Latitude value. After any manual change of the default
latitude the Gyrocompass algorithm will be automatically reset. The Gyrocompass algorithm
can be manually reset at any time by clicking the Gyro Compass Reset button.

Figure 6-9 Lodestar Gyro Compass Settings
Lodestar (==

Lodestar Connection

PC/LCH Port: 192.168.179.51:5001 | Discomnect | | Connedtion |

Lodestar Traffic | Cpu Load | Port Load | Firrnware|

From Lodestar: 2736 Bps Port Rx % Te %
To Lodestar: 38 Bps Console 0.3 324
C1 0.0 00
c2 0.0 00
Gyro Compass / AHRS T 0.0 00
Lattude: 513303 d Gyro Compass T2 0.0 0.0
- - -
Lodestar Power Management
Shutdown Lodestar 2 minutes without
automatically after power
Shutdown
‘ Reset Lodestar Lodestar |

Lodestar Mourting
Lever Amns (From Vehicle CRP) Mounting Angles (From Vehicle Frame)

Forward: Metres Heading: Degrees

Starboard: |0.000 EI Metres Resutting Pitch: | 0.000 EI Degrees

Down: Metres Resulting Roll: Degrees

o] [oomt ] ol ]

Note

Failure to update the default Latitude to match the current working area could result in poor
Lodestar gyrocompass and inertial performance. After any change of default Latitude the Lodestar
Gyro Compass algorithm is reset. During INS operations the Lodestar Latitude value will be
automatically updated by position aiding messages (USBL).

3. Setthe Lodestar Power Management time period. The Lodestar will run on its internal
battery for the selected time period (default period is 20 minutes) after the external power
supply has been stopped.

4. Enter the Lever Arms (From Vehicle CRP) offset values. After changing these values, the
Gyrocompass/AHRS and INS algorithms will be automatically reset to use the new settings.

5. Enter the Mounting Angles (From Vehicle Frame) offset values. After changing these
values, the Gyrocompass/AHRS and INS algorithms will be automatically reset to use the new
settings.

6. The Lodestar can be manually shutdown at any time by pressing the Shutdown Lodestar
button, after which the SPRINT software will also close.
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7. The Lodestar (firmware) can be manually reset at any time by pressing the Reset Lodestar
button.

8. The Lodestar can be reset if the connection between to SPRINT is via Ethernet port (E1).
Click the Connection button to open the Lodestar connection window, as shown in below.

Figure 6-10 Lodestar Connection

Lodestar

Lodestar Connection

PC/LCH Pori: 192,162,179 50:4000
Lodestar Traffic Cpu Load [ Port Load | Frmware
From Lodestar: 4239 Bps Name % Processor Time
To Lodestar: 245 Bps Lodestar 406
PCcpu2 138
PCcpu 3 13
Gyro Compass / AHRS PCepul 35

Latitude:  51.3306 deg PCecpui 17
Reset PC Load X3

Lodestar Power Management

Shutdown Lodestar 2 minutes without
automatically after power
R Shutdown

Lodestar Mourting
Lever Amn= {From Vehicle CRP) Mounting Angles {(From Vehicle Frame)
Forward: |0.000 EI Metres Heading: m Degrees

Starboard: |0.000 EI Metres Resulting Pitch: |0.000 EI Degrees

Down: m Metres Resulting Roll: m Degrees

0] tom ] [ omon

9. Click the Lodestar Hardware Reset button and then wait 3 minutes for the Lodestar to re-
establish communications with the SPRINT software.

Figure 6-11 Lodestar Hardware Reset

Connection To Lodestar E
Ethemet / LCH Serial

IP Address:  152.168.179.50

Port: 4000

Lodestar Hardwars
Reset

10. Click OK to close and save all entered settings.

Lodestar Hardware Reset - Success

SPRIMT successfully peformed Lodestar Hardware Reset.
SPRIMT will now try to establish communication with the Lodestar.
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6.3.4 Lodestar Time Synchronisation

To configure the Lodestar Time Synchronisation, proceed as follows:
1. Referto Figure 6-12. Click Configure > Time Synchronisation, or right-click on the Time

LED.
Figure 6-12 Lodestar Time Synchronisation
Time Synchronisation E
Time Synchronisation Mode
Type: |ZDAand 1PPS -

GPZDA Input

PC/LCH Port:  192.168.179.51:5003 | Corfigure
e Seccs

Port connected
1PPS Trigger Input

Lodestar Port: |E1

ZDA Amives: | After PPS -

Trigger In: o'

incone) ko) (mbtsti) |aCccie)

2. Onthe Time Synchronisation screen, select Type: ZDA Only (default) or GPZDA and
1PPS.

3. Referto Figure 6-13. Click Configure and enter the PC Port Serial IP Address
192.168.179.51, Socket 5003 via the LCH.

Figure 6-13 Adding IP Address

Time Signal input port E

Connection Type
(7 PC Serial @ Ethemet / LCH

Connection Details

IP Address: 152.168.179.51
Socket: 5003

| o

:

4. Click OK to return to the Time Synchronisation screen and enter the ZDA Latency value.

Note

The Time Synchronisation can be reset at any time by selecting Reset Time Synch.
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5. If GPZDA and 1PPS is selected then configure the 1PPS Input settings. The default Lodestar
Input setting for 1PPS is Lodestar Port C1.

6. Click OK to close and save all entered settings.

6.3.5 USBL Aiding

To configure the USBL Aiding, proceed as follows:

1. Click Configure > INS > USBL Input or right-click on the USBL Aiding LED.
Figure 6-14 USBL Aiding

USBL [=E3a]

USBL Aiding Input
Type: [USEL GGA -

PC/LCH Port:  192.168.179.51:5004

Fitter by Beacan ID

Port connected
USBL Quality

USBL Beacon Mourting (From Vehicle CRF)

Starboard: |0.000 ] Metres
Down: |0.000 % Metres
‘ QK | Apply ‘ Cancel |

2. Refer to Figure 6-14. Select a USBL Aiding Input Type: PSIMSSB (Default) or USBL GGA
(Acoustic). Typical USBL aiding inputs are as follows:

e Sonardyne Ranger/Fusion USBL or EIVA NaviPac: Acoustic GGA.
e Sonardyne Marksman/Ranger 2 or Kongsberg HiPAP: PSIMSSB.

3. Onthe PC/LCH Port enter the IP Address for the serial input via the LCH
(192.168.179.51:5004) by clicking Configure (as shown in Figure 6-13).

4. If required, specify a Beacon ID filter, see Appendix E for details of the beacon ID field of the
different USBL aiding messages.

5. USBL Aiding Quality Settings can be configured via Advanced Settings option. The default
setting is for SPRINT to use the quality value provided by the USBL system in the aiding
message, refer to Figure 6-27 (see Appendix E for details of accepted USBL message types).
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Figure 6-15 USBL Aiding Quality Settings

| —
Set USBL Quality || = M
Horizortal Quality Mode Vertical Quality

() Manual @ Use Quality From Message () Advanced

Set Manual Quality Set Scale Factor Set Vertical Guality

Horizontal Quality: Metres Scale Qualityby:  1.00 Vertical Qualty: 200 Metres
Set Quality Adjustment Set Rejection Criteria
[] Enable [] Enable

Min Horizontal Quality: Metres Max Horizontal Quality: Metres

ot i it

a. Use Quality from Message: The quality value from the USBL message can be scaled to
resolve for systematically incorrect USBL Quality.

—
Set USBL Quality E=N R g
Horizontal Guality Mode Vertical Quality
) Manual |l§w Use Quality From Messagel ) Advanced
Set Manual Quality Set Scale Factor Set Viertical Guality
Horizontal Quality: ~ [2.00 Metres Scale Qualtyby: .00 Vertical Quality: 200 Metres
Set Quality Adjustment Set Rejection Criteria
[] Enable [] Enable
Min Horizontal Quality: Metres Max Horizontal Quality: Metres
ot it izt

b. Manual: In some cases, it may be required to set a manual horizontal quality value:

e If using Sonardyne Ranger, Fusion USBL or other USBL systems where no quality
value is provided.

e The quality value provided by the USBL system is overly optimistic.

.
Set USBL Quality e B[S
Horizontal Quality Mode Vertical Guality
() Use Quality From Message () Advanced
Set Manual Quality Set Scale Factor Set Vertical Quality
Horizortal Guality: 2.00 Metres Scale Quality by: 1.00 Vettical Qualiy: —ZDD Metres
Set Quality Adjustment Set Rejection Criteria
[] Enable [] Enable
Min Horizortal Guality: Metres Max Horizontal Guality: Metres
) it il

c. Advanced: This configuration allows horizontal quality to be used from the USBL
message whilst able to set scale factor, minimum and maximum quality values for the
USBL position.

e Min Horizontal Quality: Use this quality to improve shallow water USBL aiding
(quality adjustment), when the USBL system is reporting a false (overly optimistic)
position accuracy, the minimum quality value can be set.

e Max Horizontal Quality: Use this quality value to reject very poor USBL aiding
(quality pre-filter).

Section 6 — Configuration 40



UM-8253
Issue A Rev 4

User Manual for SPRINT

[ set USBL Quality E=ER =
Horizontal Quality Mode Vertical Quality
() Manual () Use Qualty From Message
Set Manual Qualty Set Scale Factor Set Vertical Quality
Horizontal Qualty: Metres Scale Quality by:  1.00 Vertical Qualty: 200 Metres
Set Quality Adjustment Set Rejection Criteria
Enable Enable
Min Horizortal Quality: 200 Metres Max Horizontal Quality: 200 Metres
[T —[ e

d. Vertical USBL Quality: If USBL depth aiding is to be used by SPRINT, the configured
vertical quality will be used by the INS. The value should be set according to the method
of depth measurement:

e Acoustic
e Sensor Measurement

[ Set USBL Quality f=] = =]
Horizontal Guality Mode Vertical Quality

() Manual @ Use Quality From Message () Advanced

Set Manual Quality Set Scale Factor Set Vertical Quality
Horizontal Guality: ~ [2.00 Metres Scale Qualtyby: 100 Vertical Quality: 200 Metres
Set Quality Adjustment Set Rejection Criteria
[] Enable [] Enable
Min Horizortal Guality: Metres Max Horizontal Quality: Metres
it it st

6. Onthe USBL Beacon Mounting (from Vehicle CRP) enter the Lever Arm offsets from the
ROV CRP to the USBL beacon. After changing the lever arms the INS algorithm will be
automatically reset to use the new settings.

7. Click OK to close and save all entered settings.

Note

If Sonardyne Marksman or Ranger 2 software is being used for USBL aiding, configuration
instructions are provided in Section 7.1.2.
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6.3.6 Depth Aiding

To configure the Depth aiding, proceed as follows:
1. Click Configure > INS > Depth Input or right-click on the Depth Aiding LED.
Figure 6-16 Depth Aiding

Depth =
Depth Type
Type: |DigiQuartz (PSI) ~|
Depth Input
() PC/LCH Port:
|N0ne || Configure || Comms |
@ Lodestar Port:
[C1 vH Conrfigure H Comms ]
Surface
oreet s uto S
Depth Sensor Mounting (From Yehicle CRP)
Starboard: Metres
Down: |0.000 Iil Metres
[ ox [ sy || ot |

2. Onthe Depth Type drop down menu, select the Type: DigiQuartz (kPa, PSI or Metres);
NMEA DPT, External Depth or Son Depth.

3. Select a Depth Input by selecting either PC/LCH Port or Lodestar Port.

If the sensor is connected via a serial connection, select the PC/LCH Port and enter the IP
Address for the serial input via the LCH (192.168.179.51:5005) by clicking Configure (as
shown in Figure 6-13).

5. If the sensor is connected directly to the Lodestar, select Lodestar Port and the relevant
connection point (C1, T1, T2).

Note

Depth aiding sensor can be set up on the Lodestar Console Port (CP). Contact Sonardyne
support for help.

6. Refer to Figure 6-17. Click Configure and enter the Lodestar Port configuration settings.
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Figure 6-17 Lodestar Port Configuration

Click OK to save all entered settings and return to the Depth window.

Enter the Surface Depth Offset value in metres if required. If the ROV is on deck and the
ambient surface pressure is to be removed from raw pressure depth value, click Auto Set.

9. Enter the Depth Sensor Mounting (from Vehicle CRP) Lever Arm offset from ROV CRP to
Sensor. After changing the lever arms the INS algorithm will be automatically reset to use the

new settings.

10. Click OK to close and save all entered settings.

11. To view Pressure Depth Aiding residuals and depth, right-click on the Depth aiding LED and
select View Pressure Depth Aiding; see Figure 6-18 and Figure 6-19.

LBL

ngle: Valid, Time unlimit:

Section 6 — Configuration

Figure 6-18 Enable Aiding Plot

Depth DVL sV
~ ~
Configure
Disable

| View Pressure Depth Aiding

Ext Pos ZUPT

Time: 15/06/201512:15:52 .:

Figure 6-19 Pressure Depth Aiding Plot
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6.3.7 DVL Aiding

To configure the DVL aiding, proceed as follows:

1. Click Configure > INS > DVL Input or right-click on the DVL Aiding LED.
Figure 6-20 DVL Aiding

ow s

Lodestar DVL Connection
Lodestar Port: | T1 - [ Configure ] l Comms ]

Triggered by Lodestar
[ Hex-ASCII DVL Data Output

Scale Factor: % [] Mlow 3 beam salution to be used

Latency: |0.000 El Seconds

DVL Configure Sound Velocity

DVL Mounting
Lever Arms (From Vehicle CRP) Mounting Angles (From Vehicle Frame)

Forward: |0.000 El Metres Heading: |135.000 E‘ Degrees

Starboard: | 0.000 EI Metres Resulting Pitch: |0.000 E‘ Degrees

Down: m Metres Resulting Roll: |-179.900 E‘ Degrees

DVL Calibration Settings

et [tomn | [ |

2. Refer to Figure 6-20. Select the Lodestar DVL Connection port from the drop down menu,
click Apply to set the port before continuing.

Select Triggered by Lodestar checkbox if required.

Select the Hex-ASCIl DVL Data Output checkbox if the DVL will be outputting ASCII data; if
left unchecked the Lodestar will expect binary data (default).

Note

The DVL mounting angles, scale factor and latency can be calculated using the calibration
routine explained in Appendix C. If the DVL input is being configured on deck prior to the
calibration, it is recommended that the default mounting angles, scale factor and latency values
are used

Enter the Scale Factor and Latency values from the DVL calibration.

Enter the Lever Arm offsets from the ROV CRP to DVL; enter the Mounting Angles from the
ROV frame to the DVL. After changing the mounting angles or lever arms the INS algorithm
will be automatically reset to use the new settings.

7. Referto Figure 6-21. If the DVL connected to Lodestar is a Teledyne RDI unit the SPRINT
software can automatically program it for use with SPRINT. To configure the DVL click the
Auto Configure button. The DVL configuration dialog will open.

Figure 6-21 DVL Auto Configuration

Configure RDI DVL =] = =S
DVL Mods Data Format Select Data Stream
@ Triggered . @ Binary (Recommended) . @ PD4 (Recommended) .
) Free Running ©) HexASClI ® PD5
Status
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Note

Make sure the Teledyne RDI DVL is connected to the Lodestar and powered before trying to
configure it.

8. DVL Mode: If the DVL cabling will allow the Lodestar to send a trigger to the selected DVL ,
select Triggered, otherwise select Free Running.

9. Data Format: The data format output of the DVL will be set to Binary by default. If Hex-ASCII
is required, select Hex-ASCII.

10. Select Data Stream: The data stream message output of the DVL will be set to PD4 by
default. If PD5 is required, select PD5.

11. Click the Configure button to configure the DVL; the software will display the progress of the
configuration process.

12. If the DVL is already configured, the Deploy button will command the DVL to start making
measurements.

13. When the DVL has been configured return to the DVL dialog.
14. Click OK or Apply to save the settings.
15. Click DVL Calibration Settings button to set DVL Alignment and import DVL Calibration file
from Janus. For more information refer to Section 11 —DVL Calibration .
Figure 6-22 DVL Calibration Settings

DVL Mounting
Lever Arms (From Vehicle CRP) Mounting Angles (From Vehicle Frame)

Forward: Metres Heading: Degrees

Staboard: |0.000 |2 Metres Resutting Pitch: (0,000 {2| Degrees
Down: [0.000 |2 Metres Resutting Roll: |-179.800 |2 Degrees

[ DWVL Calibration Settings l

Lo J[ s [| o |

16. The DVL Alignment to vehicle frame quality options are described below.

o Calibrated: The calibrated alignment option is set as default and must be selected if
applying a DVL Calibration to SPRINT by either importing a DVL Calibration file or
manual entry.

e Pre-Calibrated: This option should only be selected if the Lodestar is co-located with a
DVL and has been pre-calibrated using GPS (RTK) prior to installation on the ROV.

e Un-Calibrated: If it is not possible to perform a DVL calibration then this option may be
selected to relax the DVL alignment error, reducing INS rejection (the DVL must be
aligned within 3° of the vehicle frame).
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Note

Contact Sonarydne support if Pre-Calibrating a DVL to a co-located Lodestar.

17. The DVL Aiding window displays the raw DVL velocities, vertical ranges and residuals that
can be selected on the View menu or by right-clicking on the DVL LED and selecting View
DVL aiding (aiding data plots can be viewed for all aiding sources except SV).

Figure 6-23 DVL Aiding Plot

¥ DVL Aiding =5 =R )

[]

Msg Format RDI PD4

ity 1509.18 m/s

solutions enabled
ation not used

-Coordinate Velocities

9.00e-003 m/s |
10:61:45 10:51:50 10:51:56
2.00e-003 mis

0.00e+000 m/s
0.010
0.00e+000 m/s

30.00 m 0005 -

30.00 m 0.000
30.00 m

-0.005

30.00 m

8.52e-003 m/s -0.010

10:51:45 10:51:50 10:51:55
2782004 m/s

-5.97e-004 m/s
0.010

Used

0005 -

-0.005 -

-0.010
10:61:40 10:61:45 10:51:60 10:51:858 10:52:00
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6.3.8 Sound Velocity

To configure the Sound Velocity, proceed as follow:

1. Click Configure > INS > DVL Input and click the Sound Velocity button or right-click on the
SV Aiding LED and select Configure.

Figure 6-24 Sound Velocity Configuration

SoundVelocity E

Sound Velocity Type
e
Salinity: |35.00 =~ PPT
Sound Velocity Input
@ PC/LCH Port:
192.168.179515005 | Configwe | | Comms |
() Lodestar Port:
v|| Configure || Comms |
Port connected
Manual Sound Velocity
1485 Metres per second
N

2. Referto Figure 6-24. Select the Sound Velocity Type from the options shown below:

e DVL Derived: valid for most ocean conditions; in this method the sound velocity is
automatically calculated using the salinity value and measurements from other aiding
sensors such as DVL (Temperature) and Pressure/Depth (Pressure).

e Various options for receiving sound velocity measurement messages from a sensor or
other sources, such as a Valeport Mini-SVS.

¢ Manual Sound Velocity.

3. If Sound Velocity messages will be received from a sensor or other source, specify and
configure either:

e The Lodestar port which will receive the Sound Velocity message (on the vehicle).

e The LCH or PC port which will receive the Sound Velocity message (topside).

4. If the Manual Sound Velocity type is selected a value can be entered in the Manual Sound
Velocity box.

5. Click OK to close and save all entered settings.
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6.3.9 LBL

To configure LBL aiding, proceed as follows:
1. Click Configure > INS > LBL Input or right-click on the LBL Aiding LED.
Figure 6-25 LBL Aiding Configuration

ﬁ

Lodestar Transceiver Connection

Lodestar Port:
12 <) | Corfigue | | Comms |

Fusion LBL Interface
Transceiver PC/LCH Port:

CoMé | Configue | | Comms |
INS PC/LCH Part:

COMS | Corfigwe | | Comms |
Port connected

LBL Aiding Range
Minimum: 25.000 [ Metres

Maxdmum: 2000.000 Iil Metres

Fusion LBL Transceiver Lever Ams (From Vehicle CRP)

Forward: 0.0000 Metres
Starboard: 0.0000 Metres
Daown: 0.0000 Metres
ok J[ e || cores |

2. Refer to Figure 6-25. Lodestar Transceiver Connection: Select the Lodestar port that the
LBL transceiver is physically connected to (usually T2) and configure the baud rate as
required by clicking Configure (see Figure 6-17).

3. Fusion LBL Interface: Specify the PC port that will be used to provide LBL transceiver
communications to the Fusion LBL software.

Click OK to close and save all entered settings.
5. Refer to Section 7.1.1 to configure Fusion LBL for use with SPRINT.

Note

Depending on the SPRINT version purchased, LBL aiding may not be available.
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6.3.10 External Position Aiding

To configure External Position aiding, proceed as follows:

1. Click Configure > INS > External Position Input or right-click on the Ext Pos Aiding LED
and select Enable. Refer to Appendix E for External position (XPOS) message format.

2. To configure External Position as an aiding source, select the External Position Aiding Input
radio button as shown in Figure 6-26.

Figure 6-26 External Position Aiding Configuration

External Position E

Bxtemal Position Aiding Input

PC/LCH Port: ~ COM111

I Comms Il Remave

Port connected

Manual Position and INS Reset

Latitude™: 51.330641 Decimal Degrees

Longitude™: -0.83569 Decimal Degrees
[] Resst INS
*In WE584

Set Position Quality
Set Manual Position Quality
Horizontal Quality: 0.30 Metres

Vertical Quality: 060 Metres

Extemal Position Mounting (From Vehicle CRP)

Forward: 0.000 lil Metres

Starboard: Metres

Oown veres
) [t [yomn

3. Click on the Configure button and select PC Serial or Ethernet/LCH. If using an
Ethernet/LCH port enter the IP Address for the serial input and socket
(192.168.179.51:5004) by clicking Configure, as shown in Figure 6-13.

4. To send a manual External Position, select the Manual Position radio button, enter the
Latitude and Longitude and click Apply or OK. Manual Position aiding will be used by the INS
without restarting the INS unless the ‘Reset INS check box' is selected.

Manual Position and INS Reset

Latitude™ W Decimal Degrees
. Longitude™; W Decimal Degrees
© Reset INS
*In WG584
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5. External Position Quality settings can be configured on the Set Position Quality pane.
Manual Horizontal and Vertical Position Qualities are set as default. Uncheck the Set Manual
Position Quality check box to use the default values. Refer to Appendix E for External
position (XPOS) message format.

Set Posttion Quality
Set Manual Posttion Quality

Horzontal Quality: 0.30 Metres
Vertical Cuality: 0.60 Metres

6. Click OK to close and save all entered settings.

6.3.11 INS

To configure the INS, proceed as follows:
1. Click Configure > INS.
Figure 6-27 INS Configuration

ﬁ

Position Aiding Inputs Depth Aiding Inputs

USBL Extemal Posttion Pressure Depth

LBL LUSBL Depth

Velocity Aiding Inpuits Extemal Position Depth
DWL

o ) [ ] (o

2. Select the INS Aiding Inputs; USBL, Pressure Depth and DVL are selected by default.

Note

The INS can be reset at any time by clicking Reset INS.

3. Click OK to close and save all entered settings.

Section 6 — Configuration 50



UM-8253
Issue A Rev 4

User Manual for SPRINT

6.3.12 Options

To configure software options proceed as follows:
1. Click Configure > Options.

2. Click the INS Position Chart Settings tab to configure preferences for the software INS chart
display.
Figure 6-28 INS Position Chart Settings
Options o] & |

INS Posttion Chart Settings | Extemal Position Chart Settings I User Limits | Misc. Dptlonsl
INS Position

Certtre on INS Position Use Shape ROV_INS -

Forward Shape Offset: 0 History Length: 500
Starboard Shape Offset: 0

Horiz. Nav Quality Measure: 1 SIGMA -

(] [ty | [ment |

3. Referto Figure 6-29. Click the External Position Chart Settings tab to configure preferences
for the software external chart display. If using Windows 7, double click on either the USBL,
INS or Transponder chart shapes to centre on the main chart.

Note

Show LBL range history can only be enabled if using Windows 7

Figure 6-29 External Position Chart Settings

Options =R =
INS Position Chart Settings | Extemal Position Chart Settings | User Limits | Misc. Options
USBL Pasition
Centre on Extemal Position Lze Shape Beacon -
Forward Shape Offset: 0 History Length: 500

Starboard Shape Offset: 0

Extemal Position
Centre on Extemal Position Use Shape Beacon -
Forward Shape Offset: 0 History Length: 500

Staboard Shape Offset: 0

LBL Transponder Position and Ranges
Show LBL beacons and ranges

Show LBL range history History Length (1to 60 mins range). 40 Ming

L] otooy | e |
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4. Refer to Figure 6-30. Click the User Limits tab to configure navigation horizontal and depth

quality limits. If the limits are enabled the software will alert the user if the limits are exceeded;
see Section 9.1.7 for more details.

Figure 6-30 User Limits

Options o B |G
[ INS Pasition Chart Settings | Extemal Posiion Chart Settings | User Limits | Misc. Options |
Enable
INS Quality Limits
Horizontal Nav Guality Limit Depth Nav Guality Limit
Quality Measure: |1 SIGMA Quality Measure: |1 SIGMA
Limit (m}:  10.00 Limit (m):  5.00

Heading Nav Quality Limit

Quality Measure: |1 SIGMA

Limit (deg): 1.00

s ot | et |

5. Refer to Figure 6-31. Click the Misc. Options tab to configure the position text type and

history length of the time series plots. It is recommended to select the Automatically Start
with Windows option.

Figure 6-31 Misc. Options

Options o] & s
[ INS Postion Chart Settings | Extemal Position Chart Settings | User Limits | Misc. Options |
Text Display Options
@ Show Position in Latitude and Longitude

(7) Show Position in Eastings and Northings

Startup Options
HAutomatically start with Windows

Time Series Limits

History Length (1to 30 mins range): 20 Mins

6. Click OK to close and save all entered settings.

Note

The Show LBL beacons and range history option within the External Position Chart Settings
tab can only be enabled when using Windows 7.
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6.3.13 Logging

To configure the Logging process, proceed as follows:
1. Click Configure > Logging.
Figure 6-32 Logging Configuration
ogging =] e =]

Log File Suffoc:

Log File Location: |C:'-.L|sers “Public’Documents*SonardyneHub"Logfiles |

Current Log File: | 000014_20150518_13.17_LS# bin |

Start Mew File Every: Minutes
Max Log Folder Size™: 10 GBytes
AP

* Oldest log files deleted when max. log folder size reached.

2. Default settings for logging are already defined but may be changed as required.
3. Clicking the Restart Logging button will close the current log file and open a new one.

6.3.14 Remote Output Points

To configure the Remote Output Points, proceed as follows:
1. Click Configure > Outputs > Remote Points.
Figure 6-33 Remote Output Points Configuration

Remote Points E

Remote Poirt A Remote Poirt B
Lever Arms (From Vehicle CRFP) Lever Arms (From Vehicle CRFP)
Forward: |0.000 EI Metres Forward: | 0.000 EI Metres

Starboard: |0.000 EI Metres Starboard: (0.000 EI Metres
Down: (0.000 EI Metres Down: (0.000 EI Metres

o [t ]| et |

2. The system can support navigation and attitude outputs with respect to two remote points on
the vehicle.

Note

By default all outputs will be with respect to the CRP of the vehicle.

3. Enter any lever arms for the remote points from the CRP to the remote point specified.
Click OK to close and save all entered settings.
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6.3.15 Lodestar Output

To configure outputs from the Lodestar ports, proceed as follows:

1. Click Configure > Outputs > Lodestar Port Outputs. Lodestar ports that are not currently in
use (connected to the topside system or to an ROV sensor) will be available to configure as
an output.

Figure 6-34 Lodestar Output Configuration
M

FEthemet | C1 T T2

[ mse Rate Ouiput Fame  Source

ERERE=)

Click the tab for the required port to configure.

Select the message type, output rate and if a remote output point is to be used (the default
output will be with respect to the vehicle CRP). For some outputs (such as a raw sensor feed)
an output rate cannot be specified as this is defined by the sensor itself.

Click Apply to configure the output.
5. If further outputs are required, click Add and repeat the configuration steps outlined above.
After configuration, click OK to close and save all entered settings.
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6.3.16 PC Port Outputs

The system supports two local output ports (primary and secondary). To configure outputs from the
local PC or LCH ports, proceed as follows:

1. Click Configure > Outputs > PCA CH Port Outputs.
Figure 6-35 PC Output Configuration

[Re/LCH Por Outputs =
Output 1 me2|omx3|omd
PC/LCH Port:  192.168.179.51:5006 Status : Port connection established

| msa Rate Output Frame Source
Sonardyne SON2 ~[10 CRP ~ | AHRsS

e =

Waming: Outputs from PC/LCH ports may be latent (<=0 5secs).
For zero latency use output(s) direct from Lodestar port(s).

Click the tab for the required port to configure.

Configure the PC/LCH Port; enter the IP Address for the serial input via the LCH by clicking
Configure (as shown in Figure 6-13).

4. Output ports can be configured for multiplexed messages as shown below.

[Pimayouputport [

Connection Type
@ PC Serial ) Bthemet / LCH

Connection Details

Comm Pert: (COM112 A
o et

ASCII
Multiplexed I

| i

5. Select the message type, output rate and if a remote output point is to be used (the default
output will be with respect to the vehicle CRP). For some outputs (such as a raw sensor feed)
an output rate cannot be specified as this is defined by the sensor itself.

Click Apply to configure the output.
If further outputs are required, click Add and repeat the configuration steps outlined above.
After configuration, click OK to close and save all entered settings.

Note

The Data Rate and Output Frame cannot be changed when selecting DVL, SVS and any Depth
messages.
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6.3.17 View Lever Arms

To view a 3D representation of the configured sensor offsets, proceed as follows:
1. Click View > Lever Arms.

Figure 6-36 View Lever Arms

2. The resulting window will display side and top views of all offsets. Note that scale is
dependent on the level of zoom applied. Use this view to check that all offsets are correct and
no errors are present.

6.3.18 View Comms Map

To view the SPRINT topside comms configuration, proceed as follows:
1. Click View > Comms Map.
Figure 6-37 View Comms Map

&2 Comms Moo o es

Port Details Input Output

Name Port Type
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6.3.19 Main Software Window

To configure outputs from the local PC or LCH ports, proceed as follows:

1. Clicking the ‘Zoom AlI’ button will auto zoom the chart on the main software window to keep
all chart shapes visible at all times.

2. Clicking the ‘Zoom In’ button will zoom in the chart display.

3. Clicking the ‘Zoom Out’ button will zoom out the chart display.

4. Clicking the ‘Erase History’ button will erase any position history trails on the chart display.

5. Clicking the ‘INS reset’ button will reset the INS.

6. All aiding inputs can be enabled/disabled for INS use or configured by right-clicking on the
appropriate aiding input LED and selecting the required option.
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6.3.20 Time Series Plots

Navigation and quality data displayed on the user interface can be graphically displayed on a chart
as Time Series Plots. Examples of plotted charts are shown below.

This time series plot shows INS Velocities North/East/Down.

This time series plot shows INS Depth, External position and INS horizontal position qualities.

6.3.20.1 Displaying Plots
The following steps describe how to display data as single and multiple plots.

1. Todisplay navigation measurements (apart from Lat and Long), quality and INS statistics,
right-click a value on the navigation text panel and select Show on New Chart Area.

2. To display additional plots on the same chart, right-click a value on the navigation text panel
and select Show on Chart Area.
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3. Toremove data from a chart, right-click the value on the navigation text panel and select
Remove Time Series Plot.

Note

There is a limitation of three sensor inputs per plot and a maximum of four Time Series Plots
displayed simultaneously, plus the LBL Aiding Plot.

6.3.21 Exporting Configuration and Log Files

To export system configuration and log files, proceed as follows:
1. Click File > Export Configuration.

24 Export Configuration and Log Files
Log File Selection
@ Last 1 Hours

(@ Fom (UTC)  18/05/201511:11:11 @~ To (UTC) 18/05/201511:11:11  [Ew

Destination and Export Settings
Destination Directory™ C]

*SPRINT exports files in subfolder "SprintExport” under destination directory.

2. Specify either the Last number of hours to export or a date/time range.

3. Specify a destination directory for the exported file.
4. Click the Export button to create the export file.
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6.4 Check List

Use the summary list below to assist in the system configuration, prior to operation:

No | Action Manual Section Checked
1 Configure the LCH 6.2
2 Check Dongle is Valid 6.3
3 Configure the Lodestar Connection 6.3.2
4 Configure Lodestar 6.3.3
5 Configure Time Synchronisation 6.3.4
6 Configure USBL Aiding 6.3.5
7 Configure Depth Aiding 6.3.6
8 Configure DVL Aiding 6.3.7
9 Configure Sound Velocity 6.3.8
10 Configure LBL Aiding 6.3.9
11 Configure External Position Aiding 6.3.10
12 | Configure INS Aiding 6.3.11
13 Configure Options 6.3.12
14 Configure Logging 6.3.13
6.3.14
15 Configure Outputs 6.3.15
6.3.16
Sign Date
Note

See Appendix H for a full step-by-step installation and setup checklist that can be printed and
used as a hard copy reference.
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Section 7 — Configuring Acoustic Aiding

7.1 Configuring Acoustic Aiding from Sonardyne Systems

7.1.1 Fusion LBL Aiding

To interface Fusion LBL to SPRINT for aiding, follow the steps below (for further information on
operation of Fusion, refer to UM-8025 “Fusion User Manual”). The instructions assume the following
connections have already been configured:

e A Lodestar is running and connected to the SPRINT software.

e LBL Transceiver is physically connected to Lodestar T1 or T2 port and is powered.

o The Fusion LBL interface ports have been configured in SPRINT (see Section 6.3.9):
e Transceiver PC Port
e INS PC Port

1. Open Fusion LBL and add an LBL Transceiver from the acoustic instruments group on the job
tree.

Create New Instrument E

- #% Transceiver
i~ Transceiver 66
USBL

% RovNav 5 (Adv)
4% RoyNav 5

nstrument Name | LBLTevr

[ ok | [ canca | [ Hew |

2. After adding an LBL transceiver, specify the PC COM port configured in SPRINT.

3. Onthe LBL Transceiver properties window, click the Advanced button to open the advanced
transceiver options window.

T ——————————
Summary / Comms | Battery / Release | Depth / Temp. / Sound Speed |
Name  LBLTow Type  Trnsosiver 66
Froquengy  MIF. Frmare | 6.01.00.03 (A)
Address 1701
Scheme  Wideband V2
Communications
Port [Peg cOM107 | Corfig. | [Show Comms
Ok J[ Concdl |[ ooy J[ Heb |
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4. Onthe Comms reset drop-down list, select None and then click Close.
Advanced Ranging Options E
s 70T Age MLast 1:1his/ 085716 24 Jun 2015 Multiuser Subscription
Multiuser emabled [ | Get Subscription Status |
Ranging power Tranzmit wait 100 % me Comman Reply Ranging
Interrogation Signal TAT [ms) poer
i . =] T
Telemetry pover Blocking delay 100 =1 ms Unknown Unknown Unknown Unknown
Receive gain | High [2EdB] ~ Wakeuptone |WakeUpl h Unknown Unkrowr U nkrn Unkrown
Fe O |
Interrogation pdGaCICIEND Activity time Unknaown Unknown Unknawn Unknawn
Individual Reply | M1701 b Detect thieshold ~ Auto Unknawn Unknawn Unknawr Urknown
Tun Around Time | 2gp g -
[millizeconds] : Extra comms g0
Acoustic Link Status
HPR Chamel .
} Comms reset el b Crozs-comelation E Telemetry Sync E
telemeh:rafgurg 3000.000 m Mote: Cornms baud rate in transceiver (L) Sl
¥ rang muzt be zet independently by the user Signal to Noise E Interference Level D
} } (6-50) [0-40]
Use in tracking [¥] Amplitude dBV E Foward Ertor
|Use diagnostics -40-0 Correction [0 - 5)
[ Get ] l Set I
| Get Link Status |
[ Show Comnms ] [ Show Moise Plat ]
Note

In later versions of Fusion, the baud rate of the transceiver may be automatically changed when it
is added. In this case the baud rate of the transceiver must be manually changed in the SPRINT
software to match Fusion and the new baud rate of the Transceiver.

5. Onthe LBL Transceiver Properties Summary/Comms tab, click Test to check connection and
communications to the Transceiver. Once connection is established the Fusion software will
confirm that the instrument is working.

W
Summary / Comms | Battery / Release | Depth / Temp. / Sound Speed |
Name LBL Tevr Type Transceiver 6G
Frequency M Fimware | B-01.00.03 (3}
Address 0
Scheme Wideband V2
Communications
Port [P2g COM107 | Config. | [Show Comms
Lok | cancel |[ ey |[LHep. ]
6. Click OK to close the Transceiver LBL Tcvr Properties page.
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7. Add a Lodestar from the non-acoustic INS instruments group on the job tree:

Create Mew Instrument E

[-F¥¥ Communications
(- GNSS Instrument
@ Heading Instrument
&1t vertical Reference Unit
L Motion Reference Unit
: Inertial Instrument
() Time Sync Instrument
% External System
J,_ Depth Instrument
---Ppi CTD ! Sound speed

Instrument Name ~ Lodestar

[ oc | | camesl | [ Heb |

8. After adding the Lodestar, specify the PC COM port that has been configured in SPRINT.
[Non-Acoustic Instrument "Lodestar” Properies (=]

Summary / Comme | Position Data | Heading Data | VRU Data | Depth Data|

Mame Lodestar Type  Lodestar ‘

Tracking

Use in tracking

|T|E|n5cei\rer [ LBL Towr-Tdr 1 ~ | Contig. Tevr ]l
| Port (B2 com10 ~|[ corfq.Por ]l
(Show Conms ] [ Tiing |

ok ][ Concel [ sooy J[ teb |

9. The PC port may be a physical COM port of a virtual serial port pair if Fusion is running on the
same PC as SPRINT.

10. Select the transceiver connected to the Lodestar from the Transceiver drop-down list.
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11. To check the Lodestar’s output to Fusion, select either the Heading, VRU, Depth or Position
tabs. The data displayed will be sourced from the Lodestar.

12. Click OK to close and save entered settings.

13. After adding the INS (Lodestar) and Transceiver, they should be listed on the Fusion LBL Job
Tree.

----- £3 Job: "LBEL Sparse1jcf"
M Units

wivFt

----- o~ Global Settings
- §¥ Geodesy

[—jé Instruments
=& Mon Acoustic

El'- Transceivers
-+ LBL Tovr

... Beacons
"eu Comms
ay@' Vehicles

.3 ROV: "ROV"
w4 Arrays

----- i Envircnmental
- Guidance

..... Repgr‘t;

14. The instruments must now be added to an ROV. Select the ROV from the job tree and then
open the Instruments tab on the ROV properties page.
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15. Add the INS (Lodestar) and the appropriate Transducer by clicking the Add button and
selecting from the list of available instruments.

Select the Instrurment or Sensor you wigh to attach to the offset and press 0K, to add it.
Mame Type Diescription
=z |BL Towr Tranzceiver BG
Trangducer
&5 Depth Senszor Strain gauge
ﬂ_ Temp. Senzar Temperature sensor
< | i | »
’ MHew ] ’ Configure ] [ Qk, I ’ Cancel ] [ Help ]

16. Adding each instrument, click the Offset Configure to enter the instrument offsets:

Iﬁ

- Instruments & Offsets Pogmomgl{}-.an
Instrument Sensor Mame Stabo...  Forward Up Instrument
ELBLTCVT Tdr 1 Cffeet1 0000m 0O000m  O0.00D
Offset2  0.000m  0.000m [ A |
Offset
] T | 3 Im’
[ ok J[ Camced J[ sty [ Hep |
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17. Enter the offsets for both instruments with respect to the vehicle CRP.

Note

The convention for the instruments may differ from the SPRINT system. These values only
require entry at this point as they will automatically be sent to the SPRINT system and the

Lodestar.
Properties for Offset "Offset2” E
General
MName Vehicle ROV

Description

Instrument Sensor Configure:

Show Label

Cffsets from the Vehicle's Common Reference Poaint
Starboard Forward Up
0.000 m 0.000m 0.000 m

(oK J[ Conced || ooy |[ Heb ]

18. Click OK to close and save all entered settings.
19. Onthe Properties for ROV window, Click the Positioning tab:

Properties for ROV "ROV" E
|Geneia| I hstllrnaﬂs&[)ﬁsets| Pasttioning |Chart |
Acoustic Update Sound Speed
Interval 10s @ Use global S
1485.00 m/s
Actual MN/A () Use local
Sync to Time Of Day |Manual || Advanced
Measurement Source
Cisplay Positions Depth
() Kalman @) Least Squares [Meast.red v] |‘IDD.DDDrn |
—_—
RMS Scale factor eading
0.000m 1 [Measuwred  ~||/0.00° |
Posttion
] Select
l escs l l References INS -
([ ok J[ conmcsl J[ sepy |[ ke

20. To use the depth output from the Lodestar select Measured as the Depth measurement

source.

21. To use the heading output from the Lodestar select Measured as the Heading measurement

source.

22. To use the INS position output from the Lodestar select INS as the Position measurement
source. Alternatively, for LBL acoustic solution, select Acoustic as the Position measurement

source.
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23. To specify the reference beacons for this ROV, click Select References:

Properties for ROV "ROV"
| General | Instruments & Offsets| Posttioning | Chart |
Aroustic Update Sound Speed
Interval 10s @ Use global B
- 1485.00 m/s
Actual N/A| () Use local
Sync to Time Of Day |Manual || Advanced
Measurement Source
Display Posttions Depth
©Kaman @ Least Squares [Measwred  ~] [100.000m |
RMS Scale factor Heading
0.000m 1 [Measued  +] [0.00 |
Position
) Select
e References INS -
ok J[ Canesl J[ ooy [[ reb |

Note

Not all reference beacons specified need to be used for INS LBL aiding but must be
specified if the SPRINT system is to record the observations for other purposes, such as post
processing in Janus.

24. After adding the references, click OK to close the Select References page.

' Select References R

Instument  Transducer  Offzet

iRl 1o Tt

Freq. Band References
MF

Offzetl

A Mote: References which are in a different frequency band from
1=y £ the sensar will be shown grayed and cannot be selected for
tracking.
Avwaiable References Selected Referances
Marme Freq. Band Type Calbrated Mame Freq. Band Type
g 1702 MF Compatt &
410> | | #1703 MF Compatt 6
{4
<< Al
[ QK ] [ Cancel ] [ Help ]

25. Click OK to close the ROV properties page. By default, all reference beacons added as
references will be used for INS aiding.
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26. To disable a beacon for INS aiding but to still record LBL data in SPRINT (for use offline) open
the properties page for the Compatt and deselect Use in INS.

m

|  Battery/Release |  Depth/Temp./Sound Speed | Roll/ Pitch
Pasition / Environmertal | Summary / Comms
Name 1703 ‘ 6
Aray Seabed
Position Sound Speed Source
E 650778.950m Major 0.000m @ Global
[ . 1485.00 m.
N 5688868.380m Minor  0-000m ® Local
. 160.000 m 0.00° —
b: Theta Manual | Advanced |
Is Calibrated E:gfh 0.000m
r
Use in Tracking Scale Factor

ke s

[ ok J[ camesd || ey |[ hHep |

27. The ROV can now be tracked using INS with LBL aiding. Click the green Go button to start the
tracking wizard.

28. Select the correct ROV for tracking and then click Tracking On.

M

Select Vehicles Sonardyne
Select the vehicles you wish to start/stop Tracking. - T
The following pages will configure the vehicles appropriately. SonMnoEN nERTH

Name Track Ac. GNSS RO Update Depth Hdg  XYDyn Depth Dyn Auto

10 Meas  Meas

Tracking On (| | Tracking Off | Mote: Scale Factor will NOT be applied during tracking
oK

<Back || MNet> | [ Fnsh | [ Caned ] [ _Hep ]
-

29. Click Next to proceed.
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30. If prompted, the transceiver may need to be set by clicking either the Quick Set or Full Set

button.
ﬁ
Sonardyne

Initizlise Transceivers
Before starting Tracking, the transceivers used for telemetry
SOIMMD IN DEPTH

and acoustic ranging must be configured.
Mame Status  Type Vehicle Telem. Freq.  Ranging Freq. Mode
@ | Bl Tewr Set Transceive... ROV MF MF Simuttaneous

FSelect Al ||| Quick Set ]]I Ful Set ||

<M[M>]|[%][W][Heb]
7

Set

31. Click Next to proceed.
32. If prompted, the beacons may need to be set using either the Quick Set or Full Set button:

ﬁ
Sonardyne

Initialise Beacons
Before starting tracking beacons which will be used
SOIMMD IN DEPTH

must be configured.
Mame Addr  Status Freq.  Inter. Reply  TAT{ms} Towr Type
[ 1702 Sed MF MFC.. M1702 200.0 Compatt &
Sed MF MFC.. M1703 3600 Compatt 6

[ ™ 1703

Amay ] | Configure

| SekatAl || Quekcset ||| s |

J [ Concel | [ e |

= T
— A

33. Click Next to proceed.
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34. Click Finish to start tracking and configure any specific Fusion log files:

Tracking Wizard @

Logging Sonardyne
If you wish to change the logfile the Tracking Data will be -

recorded in, you can do so on this page. SolmMmoEN nERTH

Log File LBL Sparse 1.mdb| Corfigure
Falder C:\ProgramData"\Documents.SonardyneFusionLBL"\Projects\LEL Sparse*Log Files"

Cumert File Size  0.119 Mb

Next > |[ Finish ]l[ Cancel | [ Hep |

7z

7.1.2 Marksman & Ranger 2 USBL Aiding

To interface Marksman or Ranger 2 USBL to SPRINT for aiding, follow the steps below. The
instructions assume the USBL system has already been configured as follows:

e Calibrated and compensated for vessel movement with a high grade MRU/AHRS.
e UC time synchronised.

e Isusing GPS (WGS84) to provide absolute positions.

e Using correct sound velocity.

¢ Is configured to track the ROV USBL beacon as a mobile beacon.

1. Addanew SSB telegram output:

n Add New Telegram

Telegram SSB_LBP
ECS SSE | BP1

e COM1 -
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2. Onthe Report Properties, select 9600 as the baud rate and select an appropriate port to
output the message to SPRINT.

3. Specify the following telegram options.
e Frame of Reference: select World
e Orientation: select Lat/Long

e Source: select Raw
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Section 8 — Operation

8.1 INS

8.1.1 Initialisation

Figure 8-1 shows a typical descent and INS initialisation sequence. To initialise the INS:

1. The AHRS algorithm should be settled. This will take 10 minutes from Lodestar start-up in the
default SPRINT configuration. The ROV can be moving. On the main software window the
AHRS status LED will be green when the AHRS is settled; see Section 9.1.2 “System and
Aiding Status”.

2. The Lodestar should be time synchronised. On the main software window the Time Synch
status LED will be green when the Lodestar is Time Synchronised; see Section 9.1.2 “System
and Aiding Status”.

3. A starting position for the INS algorithm. In normal operation this will be provided by the first
accepted USBL position for the vehicle during descent.

Figure 8-1 Descent and INS Initialisation Sequence
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8.2 Fusion LBL Aiding

8.2.1 Transition from USBL to LBL aided INS

To transition from USBL aided INS to LBL follow the steps below:

1. Make sure SPRINT has good USBL and DVL aiding (e.g. bottom lock). The ROV should
continue with some dynamics during the following steps.

2. Check Fusion is tracking and that ranges are being received on the Fusion measurements

panel.
3. Click the DVL and LBL check boxes.
]m E
Position Aiding Inputs Depth Aiding Inputs
USBL Extemal Position Pressure Depth
LEL LISBL Depth
Velocity Aiding Inputs Exdemal Postion Depth

DVL

o] (o) [t ]

4. LBL aiding can also be selected by right-clicking on the LBL LED.

5. LBL aiding can then be monitored in operation as described in Section 9.1.5.
8.3 Zero Velocity (ZUPT) Aiding

8.3.1 Features and Operational Guidelines

Zero velocity aiding feeds ‘zero’ velocities in to the INS (with an amount of error) to help the INS
estimate sensor bias errors when a vehicle is not moving. It can be used to:

e  Stop INS position drift if DVL, USBL or LBL aiding is lost

e Provide better static fix results if aiding data is poor (e.g. USBL)

Rules for Zero Velocity (ZUPT) Aiding:

Note

If Zero Velocity (ZUPT) aiding is used when the vehicle is moving the INS integrity and
performance could be affected.

e  Must ONLY be used when the ROV is truly static
e Must NEVER be used when the ROV is moving

o  Switching between USBL and LBL aiding must NOT be carried out when the INS is
ZUPT aided as it will not be allowed to move between the two positioning sources.
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8.3.2 Enabling Zero Velocity (ZUPT) aiding

Zero Velocity Aiding can be enabled by clicking the ZUPT button on the main SPRINT window, see
Figure 8-2. It can disabled by pressing the ZUPT button again. When active the INS status on the
navigation chart will display Navigating (ZERO VELOCITY).

Figure 8-2 Enabling ‘ZUPT’ Aiding

8.3.3 Static Fixes with Zero Velocity (ZUPT) Aiding

Follow the steps below if Zero Velocity Aiding (ZUPT) is to be used while taking a static fix.
1. SPRINT should be ‘healthy’ with green LEDs before taking a static ZUPT fix.

2. Manoeuvre the vehicle in to position for the static fix.

3. Once the vehicle is static enable ZUPT mode.

4. Record the static fix using 3rd party software.

5.  Turn off ZUPT mode.

6. The vehicle can now move away from the static fix position.
Note

ZUPT aiding may not be available depending on the SPRINT version purchased.
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Pre-Dive Checklist

Use the list below to assist in making sure the SPRINT system is ready before a dive.

No Action Checked

1 Check the Lodestar is powered.

> Check all aiding sensors (Depth, DVL, Sound Velocity, and LBL Transceiver) are
powered.

3 Check the default Latitude in the SPRINT software.

4 Check the Lodestar, AHRS, Logging and Time Synch status LED’s are green
(OK).

5 Check the Depth status LED is blue (not used). A red (critical) status could indicate
there is no data being received.

6 If a DVL is being used, check the DVL status LED is blue (not used). A red
(critical) status could indicate there is no data being received.

7 If an SV feed is being used, check the SV status LED is blue (not used). A red

(critical) status could indicate there is no data being received.

If connected to an LBL transceiver, open the Fusion software and check the
8 Transceiver connection by performing a ‘Get’ or ‘Test’ on the transceiver
instrument page.

Check or set the (surface) pressure offset on the depth aiding page of the SPRINT
software.
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Section 9 — Maintenance & Monitoring

9.1 Monitoring the System

9.1.1 Main Application Window

The main software window, with USBL, DVL and Depth aiding active, with key features highlighted
is shown below in Figure 9-1.

Figure 9-1 Main Application Window
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9.1.2 System and Aiding Status

Refer to Figure 9-2. All the major system components and aiding inputs can be monitored via ‘traffic
lights’ at the bottom of the main software window:

Figure 9-2 System and Aiding Status

System Status Aiding Inputs
Lodestar AHRS INS Logging UsaL LeL Depth DVL ZUPT

0000 000000000
The following system components are always monitored:
o Lodestar (Hardware)
e AHRS (Attitude Heading Reference System)
¢ INS (Inertial Navigation System)
e Time (Synchronisation)
e (Local PC) Logging

Aiding inputs are monitored if they are specified for INS aiding in the INS Settings configuration. The
colour of the monitoring ‘traffic lights’ is explained in Table 9-1.

Table 9-1 System and Aiding Status ‘Traffic Light’ Colours

Status ‘Traffic Light’ Colour |[Example States

Communications Failure to Component

Hardware Issue

Component not Initialised or running correctly

Timeout for Critical Instrument (typically 30 second limit)

Critical Red

Aiding Sensor Data Rejected

Warnin Orange / Ambe i i
rning rang r AHRS Algorithm Settling

Data Received within Time Limit

OK Green

Data Accepted and Used
Not Used or Blue Aiding data is received but as the INS is not initialised it is not yet
Disabled being used.

A text description for each component status is provided in the status list and can also be seen by
placing a mouse over the appropriate LED, as shown in Figure 9-3 (with the example of the INS
being unable to initialise as it is not receiving position). If there is an issue, the status text will
provide guidance to resolve it.

Figure 9-3 Component Status Popup
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9.1.3 Navigation Text Panel

Real time navigation data is displayed on the navigation text panel. All positions can either be
displayed in WGS 84 decimal degrees or UTM Eastings and Northings. Various quality metrics are
also displayed on the panel for both the INS and the Lodestar time synchronisation status.

Figure 9-4 Navigation Text Panel

0.53

130.00

1.40

130.00

INS to USBL Difference
| 0.19 |

Time Synch

Note

The displayed USBL beacon position and external depth are with respect to the vehicle CRP to
allow for direct comparison with the INS position, which is also with respect to the vehicle CRP.
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9.1.4 INS Statistics

Refer to Figure 9-5. To view detailed INS performance statistics, from the menu Click View > INS
Statistics:

Figure 9-5 INS Statistics
i INS Statistics =] @ =]

.

Position
Latitude 51° 19.8385' N North 0.007
Longitude 000° 50.1414" W East 0.014
Depth 3011 m Down 0.030

1DRMS 1.16 m Depth | 0.050

Semi Min. .82 0.013

Onentation

0.000 0.020 “lhr Heading 249.911 ° Heading 249911 °
0.000 0.020 “Ihr Pitch 0374 © Pitch 0.374 °
0.000 0.020 “Thr Roll 0.155 ° Roll 0.170 °

Heading 1.000 ° Heading 0.001 °

R/IP 0.055 ° Pitch 0D.015 °
Roll 0.005 °

Alpha ("Roll") 0.000 = 0.500 : 0.000 = 0.005
Beta ("Pitch”) 0.001 = 0.500

Gamma ("Heading”) 0.000 = 0.500

Note

If the INS Statistics display is closed while in use as Time Series Plots, the plots will be deleted.
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9.1.5 INS with Fusion LBL Aiding

When LBL is selected and used as an aiding source in SPRINT, there are some features that
should be noted in the SPRINT software. See the LBL aiding example in Figure 9-6. When LBL
aiding is active the USBL position is still displayed for comparison but is not used for aiding.
Additionally the INS error ellipse may take a distinctive shape that is representative of the geometry
of the vehicle with respect to the reference beacons used for aiding.

Figure 9-6 SPRINT with Fusion LBL Aiding

If any LBL ranges are rejected, the LBL aiding ‘traffic light’ will change to amber/orange and the
beacon address and reason for rejection will be displayed. Examples showing reasons of LBL
rejection are shown in Figure 9-7.

Figure 9-7 LBL Aiding Rejection
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Click View > LBL Aiding to see additional LBL aiding information as shown in Figure 9-8.
Figure 9-8 LBL Aiding Window

. LBL Aiding |E=H EoR [

DABD foeeerngereieineens

0.400 SR S

1 O O S SO SO—

0.00 dB 1300 SSENS SES S

12:06:30 12:07:00 12:07:30 12:08:00

0.00 dB

Used
-0.050 |-
-0.100 |-

-0.150

12:06:00 12:06:30 12:.07:00 12:.07:30 12:08:00

The LBL aiding window will display aiding information for all LBL beacons which are currently being
tracked while SPRINT is LBL aided.

The upper graph displays travel time for all tracked beacons while the lower graph displays the LBL
aiding range residuals. The residuals displayed are the differences between the INS estimated and
the actual received LBL ranges and are therefore an extremely useful indication of LBL aiding
health. The residuals should typically be low (<10cm) and centred around zero.

To edit the LBL aiding chart contents:
1. Press the minus sign —. on the keyboard to hide the beacon text.
2. Right-click on the charts to enable options to:
e Maximise or hide one of the charts
e Show or hide data from individual beacons
e Copy and save the charts

3. Dragging the mouse over a section of the chart will zoom into the area selected.
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is recommended that during critical INS positioning with LBL aiding, the LBL aiding window is kept
open to monitor the aiding, as shown below in Figure 9-9.

Figure 9-9 Monitoring LBL Aiding

If the residuals are not centred around zero, this would indicate that there is a systematic error with
LBL aiding, such as:

e  Sound velocity

e Beacon to INS relative depth

If LBL aiding observations are rejected, it will be indicated by a red cross on the residuals display,
as shown in Figure 9-10.

Figure 9-10 LBL Aiding Rejection in Residuals Graph
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9.1.6 Communications Monitor

From any of the dialogs in the SPRINT software that allow the configuration of input or output
communication, a comms monitoring function is provided. When the Comms button is clicked, a
new window is displayed showing the received or sent data on the configured port; see Figure 9-11.
The actual message contents are provided in the Message column.

Figure 9-11 Communications Monitor

A Depth Lodestar Comms... - - - Fm|
[ Ascil |[ Hex ][ ToFie | C:\Users\Public\Documents\Sonardyne\Hub [ ... | Highlight:
Timestamp Message -
10:22:35.915 *0001150.0500

10:22:36.836 #FRDID,-0.34,0.15,250.02%52

10:22:36.916 *0001150.1100

10:22:37.335 4PRDID,-0.34,0.15,250.02%52

10:22:37.917 *0001150.0700

10:22:33.3833 4§PRDID,-0.34,0.15,250.02%52

10:22:33.918 *0001150.1200

10:22:39.841 $PRDID,-0.34,0.15,250.02%52

10:22:39.918 *0001150.0500

10:22:40.835% $PRDID,-0.34,0.15,250.02%52 EI
10:22:40.%20 +*0001150.1100 -
2K 30 30 20 31 31 35 30 2ZE 21 31 30 20 *0001150.1100

Status: Connected

The data received on the port is displayed green and the data sent on the port displayed blue as
shown in Figure 9-11. The communications can be saved to a file by selecting a location and
clicking the To File button. The communications can be filtered by entering Filter text. Any
communication containing the filter text is displayed red as shown in Figure 9-12.

Figure 9-12 Communications Monitor Filter

[ ascil |[ Hex ][ ToFile ] Ci\Users\Public\Documerts\Sonardynentn [ .. | Highlight: 0.1 >
Timestamp Mezsage *
10:23:15.833 &PRDID,-0.34,0.15,250.02*52

10:23:15.920 *0001150.0500

10:23:16.840 &PRDID,-0.34,0.15,250.02*52

10:23:16.950 *0001150.1100

10:23:17.840 &PRDID,-0.34,0.15,250.02*52

10:23:17.957 =*0001150.0700

10:23:12.237 $PRDID,-0.34,0.15, 250.02+52

10:23:18.958 =*0001150.1200

10:23:19.837 $PRDID,-0.34,0.15, 250.02%52 E
10:23:1 *0001150.0500

10:23:20.234 $PRDID,-0.34,0.15,250.02#52 o

The communications stream can be paused by pressing the Pause button.
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9.1.7 Navigation Quality Limits

Navigation quality limits can be enabled and configured in the SPRINT software (see Section
6.3.12). If enabled, the horizontal navigational quality limit will be displayed on the chart as a red
circle (NB: INS horizontal quality is displayed as a yellow circle or ellipse). If either the vertical or
horizontal quality limits are exceeded, the software will alert the user as shown in Figure 9-13:

e The ‘Compass Ring’ on the navigation chart will flash red.
e The INS status on the navigation chart will read ‘Quality Exceeds Limit’.
e The relevant quality value on the navigation text panel will flash red.

Figure 9-13 Navigation Quality Limits Exceeded

9.2 Maintaining the System

9.2.1 Logging

The system is configured to log all sensor data and internal state messages to allow for offline
analysis, post processing and QC of real time SPRINT navigation.

Data is logged automatically onto a local PC directory as configured previously. An automatic
background process will make sure that the Navigation PC hard drive does not become full by
deleting the logs in date order.

The same data is also logged internally within the Lodestar on an 8GB SD card. The SD card data
can be retrieved using the Lodestar Configuration software; refer to the UM-8084-107 “Lodestar
AHRS Manual” for instructions.

9.2.2 Lodestar Firmware

The Lodestar firmware can be upgraded using a direct serial connection (not via the LCH); refer to
the UM-8084-107 “Lodestar AHRS Manual” for instructions.
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9.2.3 SPRINT Security Key Dongle Update

The SPRINT security key dongle can be updated using the following procedure:

1. Refer to Figure 9-14 and Figure 9-15. On the Windows Start menu, click All Programs >
Sonardyne > SPRINT > Security Tool.

2. Click Request Update and email the reference code to support@sonardyne.com with the
dongle request update.

3. To activate the dongle update click Apply Update, select the .DUP (Dongle Update Packet)
file received from Sonardyne Support.

Figure 9-14 SPRINT S5 Settings

- Security Key Tool . - .L.

Securty Key Information

Securty Key [SEA4 03 -
Applications |EREITIE

Info SPRINT application settings:- -
Key Type: Primary
Expiry Type: Never Expires
Expires  in: Time unlimited
set: n/a
Enabled options:
USBL: e
LBL: False
DVL: True
Pressure: True
GPS: False
ZUPT: False
ZMD: Falze

Extemal Posttion:  True

Time Stamp 29/06/2015

[ Request Update |

[ Apply Update J
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Figure 9-15 SPRINT S10 Settings

Lol Security Key Too

Securty Key Information

Secuty Key
Applications |ETEINES

Info SPRINT application settings - -
Key Type: Primary
Expiry Type: Never Expires
Expires  in: Time unlimited
set: n/a
Enabled options:
USBL: True
LBL: True
DVL: True
Pressure: True
GPS: False
ZUPT: True
ZMD: True

Extemal Posttion:  True

Time Stamp 29/06/2015%

[ Request Update J

[ Apply Update J
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Section 10 — Functional Test

10.1 Testing

It is strongly recommended the SPRINT system kit is assembled, tested and operated prior to
installation on the subsea vehicle. A full set of Lodestar test cables is supplied with each SPRINT kit
for that purpose.

Note

The Lodestar Communications Hub and associated power cable can be used to provide 48v
power to the Lodestar during this test.

The functional test will check that:

1. A connection can be made between the Lodestar and Lodestar Communications Hub prior to
it being routed through any interfaces between the subsea vehicle and the vessel.

2. The Lodestar has the correct firmware and is enabled for use with SPRINT.
Basic inertial navigation can be initialised.

To undertake the test follow the operational steps listed in Section 6 — Configuration prior to
vehicle installation.

Section 10 — Functional Test 87



UM-8253
Issue A Rev 4

User Manual for SPRINT

Section 11 — DVL Calibration
11.1 DVL Calibration Procedure

An accurate calibration will typically require ~15-20 minutes of manoeuvring at the seabed. A quick
calibration can be done in just a few minutes. Follow the instructions below to undertake a DVL
calibration.

Prior to the start of the calibration, make sure the following conditions apply:
e The subsea vehicle must be within DVL range of the seabed with good bottom lock.
e The subsea vehicle is being tracked with USBL and SPRINT is receiving USBL aiding.
e The Pressure Depth input is active and SPRINT is receiving Pressure Depth aiding.

e The correct sound velocity is being used by SPRINT.

1. Itis recommended to start a new log file with a suffix that will be clearly identifiable as DVL
calibration data.

2. Open the Logging dialog and enter the required log file suffix (e.g. DVLCalibration).
Figure 11-1 DVL Calibration Logging Configuration
Logging e = =]

Log File Suffic: DVLCalibration 1|

Log File Location: |C:"-.Users"-.F‘uinc"-.Documerrts"'-.SDnal‘dWB"'-.Hub"-—.Logf iles |

Cumertt Log File:  |000213_20150630_12.29_LS.bin |
Start New File Every: Minutes
Max Log Folder Size™ 10 GBytes

ok ||| eoly || concel |
* Cldest log files deleted when max. log folder size reached. m

Click OK to close and save all entered settings.

The subsea vehicle can now undertake some specific manoeuvres. A suggested and efficient
approach would be to travel along an approximate linear path and the vessel to follow the
ROV and maintain a constant heading (to minimise USBL systematic error) whilst performing:

e Accelerations along various axes including up/down.
¢ Heading changes +/- 90°, i.e. sideways movement maintained for a few minutes.
e Random high dynamic manoeuvres

5. Atotal position change of ~500 metres is sufficient. For deep water, make the
trajectory/duration longer for optimum performance.

Figure 11-2 DVL Calibration ROV Manoeuvres
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6. To minimise USBL systematic error, the vessel must follow the ROV maintaining constant
heading during the calibration.

7. When the calibration manoeuvres have been completed the subsea vehicle can continue with
other operations.

8. Open the Logging dialog box and enter a log file suffix to indicate the log files no longer
contain any DVL calibration data, the default log file suffix is LS.

9. Create a working folder on the hard drive for the DVL calibration log files; e.g. My
Documents\DVLCal. Create a subfolder in the working folder called LogFiles.

Note

SPRINT binary log files have a .BIN extension.

10. Copy the relevant log files from the SPRINT logging location into the LogFiles folder; e.g. ‘My
Documents\DVLCal\LogFiles’. SPRINT.

Note

Itis important to only copy the log files covering the time period of the DVL calibration
manoeuvres as time taken to process the log files will increase with the amount of data used.

11. Run the DVL Calibration tool by double-clicking the icon on the desktop (it may be necessary
to wait up to 10 seconds for the application to run):

12. The DVL calibration application will open on the AINS tab.

13. Click the Choose job/root directory button and select the parent working folder, e.g. ‘My
Documents\DVLCal’, and click OK.

7
B sonardyne - Janus DVL cal. (ver. 1.1.0.7) =N =R

[ DVi-Galibration | 111U Calibration [ _anrs | Bport
AINS | Aiding sensor. Log files/Import.data

lob directory: |Choosejobfroot directory --> | || Choose job/root directory ||

Navigate

Time Selection

@ All available data.

Time span: | from plot |

Start from position (nearest to): |[lat (rad)

| Change cenfiguration

First good DVL observation.
First good USBL (Remote) observation.

Plotting
Nawgatlor1:| M/A hd |Referer1ce:| None A |
Plot:| Trajectory ” KF-states ” Observation Used ‘
Plotting tool;:l Sync. plots ][ Close plots ]
Time conversion
Input time: <input time>
UTC time: <UTC time>

System time [min]: <Internal time>
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14. Click the Log file/lImport data tab.

a Sonardyne - Janus DVL cal. (ver.1.1.0.7)

| DVL Calibration I InvU Calibration I LHBS =
| AINS | Aidingsensar, I Log files/Import data
Import data
Irmport data from Lodestar log files. Log files are assumed to
be in the sub-directory logfiles. Import all

Imported data:

15. Click Import data to import the data from the LogFiles, this may take several minutes. When
the import is completed a list of imported data is displayed:

%4 Sonardyne - Janus DVL cal. (ver.11.0.7)

[ DVL Calibration [ IMU Calibration [ aHrs | Exoort

| AINS | Aiding sensor | Log files/Import data
Import data
Irmport data from Lodestar log files. Log files are assumed to
be in the sub-directory logfiles. Import all
Imported data:
MU DvL Pressure depth USBL (Remote) Sound velocity
Time system  Fixed depth  ZUPT AHRS BIST
RT AIMS Settings

16. Click the DVL Calibration tab.

l Sonardyne - Janus DVL cal. (ver. 110.7) EEIL.

Log files/Import data

DVL Calibration IMU Calibration

Enter an initial guess or leave it to use either Command & Control settings or
default values, Note that the mounting angles are in Vessel frame,

Once done, press use calibration in order to use the DVL calibration for navigation.
The DVL calibration is also affected by the time selection on the AINS tab. Use it to
perform a calibration using only a subset of the data.

Parameter Initial Estimated Std.Dev  Unit
Roll -179.9 0.000 0.000
Pitch 0 0.000 0.000
Heading 135 0.000 0.000
Scale-factor 0 0.000 0.000 %
Latency 1] 0.000 5
Calibrate DVL

Automatic sensor selection
Bypass coarse estimation
Diagnose calibration

Plot DVL residuals

17. The initial (default) values will be displayed. They do not need to be modified.
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18. Click the Calibrate DVL button. A progress indicator will show the processing status.

19. When completed, two figures will be displayed. Figure 1: DVL Calibration displays the DVL
velocity residuals for all axes before and after calibration.

1] Figure L: DVL calibration
File Edit View Inset Tools Desktop Window Help

NOHS AR UDE£- |2 0 e

DVL residuals before calibration

<

Velocity residual [m/s]

Melocity residual [mfs]

System Time [min]

20. Figure 2 DVL Calibration displays the DVL velocity residuals for each axes before and after
calibration.

1 Figure 2: DVL calibration =5 ECR(E
File Edit View Inset Tools Desktop Window Help

Nede |09 4L- (2 IO

DVL residuals comp.

=
[

Welocity
residual [m/s]
(=]

Welocity
residual [m/s]

Welocity
residual [m/s]

System Time [min]
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21. Onthe DVL Calibration tab the estimated calibration values are displayed.

B Sonardyne - Janus DVL cal. (ver. 1.1.0.7) =R ==

DVL Calibration

Enter an initial guess or leave it to use either Command & Control settings or
default values. Note that the mounting angles are in Vessel frame.

Once done, press use calibration in order to use the DVL calibration for navigation.
The DVL calibration is also affected by the time selection on the AINS tab., Use it to
perform a calibration using only a subset of the data.

Parameter Initial Estimated Std.Dev  Unit
Rell -173.9 -179.955 0.098
Pitch 0 0396 0.077
Heading 135 135,300 0145
Scale-factor 0 -0103 02211 %
Latency 0 0.001 5
Calibrate DVL

Automatic sensor selection
Bypass coarse estimation
Diagnose calibration

Plot DVL residuals

’ Use calibration ] ’ Save calibration report ]

22. ltis recommended a (PDF) copy of the DVL calibration report is saved by pressing the Save
calibration report button and specifying an appropriate location.

23. Open the report to retrieve the results (they are also available directly from the DVL
Calibration tab):

Results:
DVL params a(rol)[7] | b(pitech) [ |g (heading) [] s?r'ri:"[‘.f:i’r Latency [s]
Before ~179.900 0 135.000 0 0
Calculated -179.955 0.396 135.300 -0.103 0.001
Calculated Accuracy 0.098 0.077 0.148 0.221

24. In the SPRINT software, navigate to the DVL dialog box (Configure > INS > DVL Input).
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25. Enter the calculated values on the dialog and click Apply or OK to save the changes:
o

Lodestar DVL Connection

lodestarPot. [T v] | Conigwe | | Comns |

Triggered by Lodestar
Hex-ASCII DVL Data Output

Scale Factor: % Allowe 3 beam solution to be used

Latency: |0.000 {2] Seconds

DVL Configure Sound Velocity
DVL Mourting

Lever Ams (From Vehicle CRP) Mounting Angles (From Vehicle Frame)

Farward Metres Heading: m Degrees

Starboard: |0.000 EI Metres Resulting Pitch: |0.000 EI Degrees

Down: |0.000 EI Metres Resulting Roll:  |-179.500 EI Degrees

DVL Calibration Settings

o) o] [

26. DVL Calibration results can be imported into SPRINT, select Save Calibration Report to
produce the import file within the Janus DVL Calibration data folder.

— Sanardyne - lanus DVL cal. {ver. 11.0.7) EE!.L.

[ amns | Aidina sensor | Log files/Import data
DVL Calibration IMU Calibration AHRS Export

Enter an initial guess or leave it to use either Command & Control settings or
default values. Note that the mounting angles are in Vessel frame.

Once done, press use calibration in order to use the DVL calibration for navigation.
The DVL calibration is also affected by the time selection on the AINS tab. Use it to
perform a calibration using only a subset of the data.

Parameter Initial Estimated Std.Dev  Unit
Roll -179.9 -179.955 0.098
Pitch 0 0.396 0.077
Heading 135 135300 0148
Scale-factor 0 -0.103 0.221 %
Latency 0 0.001
Calibrate DVL

Autematic sensor selection
Bypass coarse estimation
Diagnose calibration

Plot DVL residuals

Use calibrati ] [ Save c report I
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27. To apply the DVL Calibration settings, open DVL Aiding in SPRINT and click DVL Calibration
Settings.

DVL E
Lodestar DVL Connection

Lodestar Port: [T - l Conrfigure l l Comms l

Triggered by Lodestar
Hex-ASCII DVL Data Output

Scale Factor: | 0.000 EI W Allow 3 beam solution to be used

Latency: |0.000 EI Seconds

DVL Configure Sound Velocity
DVL Mourting

Lever Ams (From Vehicle CRP) Mounting Angles (From Vehicle Frame)
Forward: |0.000 EI Metres Heading: m Degrees

Starboard: Metres  Resulting Pitch: Degrees
Down: m Metres Resuting Roll: Degrees

DVL Calibration Settings

O N

28. Select the Calibrated radio button and click Import DVL Calibration File.

29. Select the DVL Calibration file (.ccl) and click OK, this will apply the DVL mounting angles,
scale factor and latency.

Note

The DVL Calibration import is only supported in Janus V1.1 software.
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Section 12 — Fault Diagnosis

The following sections suggest possible causes and/or solutions for problems that may be
experienced for each system component. If, after checking the causes and solutions listed below
the problem is still occurring please contact Sonardyne Support. You may be requested to provide a
system configuration export as described in Section 6.3.21.

12.1 Lodestar Connection

When connecting the Lodestar, carry out the following:
1. ALWAYS configure and check Lodestar connection prior to mounting on subsea vehicle.

2. Make sure the Lodestar is fully charged (2-3 hours) prior to vehicle connection tests to
eliminate any communication failures due to intermittent connections and power loss.

3. Once the Lodestar is mounted on the vehicle, connect a laptop using test cables to verify
Lodestar operation and sensor communications.

Ethernet — check vehicle supports 100 megabit.
5. Serial — check 232 485 cable select for console port connection issues.

12.2 Attitude Heading Reference System (AHRS)

When using the AHRS, make sure:
1. The default Latitude is set.

2. There is a constant bias noted. If so, check Lodestar mounting angles, lever arms and remote
output points if configured.

12.3 Inertial Navigation System (INS)

When using the INS, make sure:

1. Generally, INS will always reject for a valid reason. Rejection indicates issues for investigation
on the aiding sensor.

2. The most common reason for rejection of time stamped data (GPS / USBL) is an incorrectly
configured time synchronisation.

3. If bad aiding data is accepted as good then INS may report Bias, Accelerometer or Heading
warnings.

4. Following other troubleshooting steps first (INS is last port of call for issues/errors).

12.4 Time Synchronisation

When using the Time Synchronisation process, make sure:
1. If ZDA only is used, latency MUST be set.

2. The ideal method is ZDA and 1PPS, verify the PPS indicator LED on the Time
Synchronisation window is active once per second.

3. Make sure any time stamped aiding (GPS/USBL) is also UTC time synched; check in comms
viewer.
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4. If Lodestar is synchronised to difference time base than GPS/USBL the behaviour to notice is:
e Lodestar accepts position data while static

e Lodestar rejects position data as soon as it moves

Note

Rejection reason might be ‘outside INS estimate’ rather than indicating a time synch issue, an INS
cannot tell the difference.

12.5 Aiding Inputs (All)
When using Aiding Inputs, make sure to:
1. Check input using:
e Comms Monitor
e Lodestar Port Traffic

2. Check lever arms and mounting angles.

12.6 USBL Aiding

When using USBL Aiding:

Make sure the USBL system is UTC time synched.

Check UTC time stamp in telegram is correct.

Make sure the Radians Lat/Long are selected for PSIMSSB message.

Check that measured rather than filtered is selected (raw position is required).
Make sure beacon ID is correct.

Check USBL setup:

e Lever arms and angular corrections (calibration)

L T o o

e Sound velocity

12.7 Depth Aiding

When using Depth Aiding make sure:
1. The correct units are selected.
2. To check surface correction.

12.8 Doppler Velocity Log (DVL) Aiding

When using a Doppler Velocity Log Aiding system, make sure:
1. The DVL is configured correctly.
2. The sound velocity is correct.
3. The latency and scale factor are configured correctly.
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12.9 LBL Aiding
When using LBL Aiding:

1. Is Fusion sound velocity correct?
2. Is ROV to Beacon(s) relative depths correct?:
o Tide
e Absolute->Corrected
Has INS had time to move between USBL and LBL?
How does this beacon fit into array?
Can the acoustic LBL position be used for comparison?

o 0k~ w

Are the minimum/maximum range settings correct?

12.10 External Position Aiding

When using External Position Aiding:
1. Make sure the External Positioning system is UTC time synched.
2. Check UTC time stamp in telegram is correct.
3. Make sure the Lat/Long are in WGS84 degrees.
4. Check External Position setup:
e Lever Arms

o Quality
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Section 13 — Retrieval and Storage

13.1 Dismantling

Before dismantling the equipment, make sure Section 2 — Safety is read and fully understood.
It is recommended that any packaging supplied with the SPRINT system is retained for future use.
If the system is to be returned to Sonardyne International, it must be dismantled as follows:
1. Make sure the SPRINT software is stopped and closed.
Make sure the power to the LCH is switched OFF.
Make sure the power to the NAV PC is switched OFF.
Rinse all subsea equipment with clean fresh water. Dry with lint free cloth.
Disconnect all connections at the rear of the LCH.
Disconnect all connections at the rear of the NAV PC.
Disconnect all connections to the top of the Lodestar.
Check all the equipment for signs of damage or corrosion.

© ©o N o DN

Any problems encountered then please contact your nearest Sonardyne office.

13.2 Storage

On completion of all checks in the previous section the equipment can be placed in storage as
described below. Refer to Table 13-1 for the recommended storage conditions.

1. Store the equipment in its transit case.

2. Equipment must be kept in a dry, non-condensing atmosphere (20% to 80% humidity), free
from corrosive agents and isolated from sources of vibration.

3. The packaging should be stored on solid, level and damp proof floors. It must not be stored
directly on damp or dirt floors or areas prone to flooding. In this case suitable shelving raised
off the floor should be used.

It is recommended to visually inspect the equipment at least annually.

5.  When equipment is taken from low temperature storage for immediate use its temperature
should be raised to normal operating temperature before use.

Table 13-1 Storage Conditions

Item Specification
Storage Temperature -20 to 55°C (see Note below)
Relative Humidity 20 to 80% (non-condensing)
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Section 14 — Spares

14.1 Introduction

There are no spares supplied with this system.

14.1.1 Component Identification Table

Refer to the list below when contacting Sonardyne International or your local office to identify any
required component.

Table 14-1 SPRINT Component Identification Table

Stock Code Description Quantity
620-0196 NAV Computer i7 - 8026-000-07-A10a 1
610-0059 OEM WINDOWS 7 Pro for embedded 1
272-0345 Cable Mains Plug to straight 2
272-0352 Cable Euro Plug to straight 2
272-036C Cable USA Plug to straight IEC 2
222-6004 SCR SL PAN HTS Chemi BLK M6X16 8
205-0832 Schroff 21100-015 F/Panel plastic washer 8
820-6592 Earth Strap Eyelet Type - 8020-075-Al 2
280-4001 Cable CAT.5e UTP patch 5M - RoHS 1
272-0793 Video DVI-DVI Interface Cable - RoHS 1
280-4714 Serial Data Cable 9 pin SUBD M/F 5M 8
272-0291 Cable CAT.6a SSTP patch 0.3m - RoHS 1
620-0142 LCH assembly - 8184-000-01-A5¢ 1
280-4198 Cable BNC to BNC 3 m - RoHS 1
820-0216 LCH 48V Power Test Cable Assy - 8184-015-Ala 1
755-0003 Lodestar Mounting Ring 8147-028-Ala 1
327-120C Fuse A/S 20MM 3.15a 1
212-1321 SCR SKT CAP S/S M8x25 A4-70 8
620-0203 SPRINT Software - 8253-101 1
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Table 14-2 Lodestar Component Identification Table

Stock Code Description Quantity
8084-3110 Lodestar 3K 5-CONN - 8084-000-3110-B9 1
8084-5310 Lodestar 5K 5-CONN - 8084-000-5310-B9 1
317-5404 CON U/W 6W I/L MP MICRO 2
317-5383 Con U/W 8W I/L FS Micro 1
317-5384 Con U/W 8W I/L MP Micro 2
317-5385 Con impulse locking sleeve 5
820-0067 Lodestar Subsea Console Test - 8084-136-04-A2a 1
820-0070 Subsea Lodestar comms C1 TEST - 8084-137-04-A2a 1
820-0072 Subsea Lodestar Comms Ethernet - 8084-138-04-Ada 1
820-0078 Subsea Lodestar TCVR Test - 8084-139-04-A3 2
998-0137 Subsea Gyro drilling template - 8146-200-A2 1
620-7214 Lodestar-2 software CD - 8084-114-H1 1
920-0090 Lodestar Manuals CD 8084-250-A5 1
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Appendix A — Lodestar Angle Definitions

A.1 Euler angles (Tate Bryan Rotations)

The “Tate Bryan” rotations given hereafter are commonly and henceforward referred to as the Euler
angles even though they are formally just a specific sequence of a larger set of possible Euler angle
rotation sequences. The Euler angle rotation sequence from NED (Earth Frame; x-North, y-East, z-
Down) to body frame is:

1. Rotation by the heading angle ¢ (phi) about Zned.
2. Rotation by the pitch angle 8 (theta) about the resulting Y axis.
3. Rotation by the roll angle y (psi) about the resulting X axis.

Similarly, the rotation sequence from a reference frame (ROV) to a sensor frame (IMU, USBL, DVL)
is:

1. Rotation by the gamma angle about Zref.
2. Rotation by the beta angle about the resulting Y axis.
3. Rotation by the alpha angle about the resulting X axis.

A.1 Heading (Azimuth, Yaw)
Heading is the angle between Xned and the projection of Xb into the horizontal plane (XYned)

measured about Zned. Heading is in the interval [0° ... 359.999°], Yaw is in the interval [-179.999° ...
+180.000].

A.2 Pitch

Pitch is the angle between Xb and the horizontal plane (XYned). Pitch is positive when Xb is pointed
above the horizontal plane. Pitch angle lies in the interval [-90° ... +90°].

A.3 Roll

Roll is the angle between Yb and the horizontal plane measured in the ZYb plane. Roll is positive
when Yb is pointed below the horizontal plane. Roll angle lies in the interval [ -180° ... +180°].

A.4 Gravity (Datawell) Angles
Gravity angles are typically returned by a gyro and traditional VRUs measuring the angle of the

gravity vector using 2 independent orthogonally mounted tilt sensors e.g. Datawell, TSS or Watson
VRUSs. These are generally defined as follows:

A.5 Pitch

Angle between the vessel forward axis and the horizontal, positive when bow is pointed above
horizontal.
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A.6 Roll

Angle between the vessel starboard axis and the horizontal, positive when starboard is pointed
below horizontal.

A.7 Heading

Angle from the North axis to the vertical projection of the vessel forward axis onto the horizontal,
measured about the down axis.

Appendix A — Lodestar Angle Definitions 102



UM-8253
Issue A Rev 4

User Manual for SPRINT

Appendix B — Reference Frames and Angular Conventions

B.1 Lodestar Frame

The Lodestar frame is a fixed right-hand coordinate frame X Y Z. Typically Lodestar is mounted so
that the X axis is approximately coincident with vehicle forward; the Y axis is coincident with vehicle
starboard; and the Z axis is coincident with vehicle down.

Lodestar has the X and Y directions displayed on the top of the unit as an orientation aid during
installation. Additionally, all measurements involving the Lodestar should be made with respect to
the unit’'s centre of axis (see Lodestar Hardware Manual UM-8084-101).

Lodestar angular outputs are defined in Gravity (or Datawell) angles; see Appendix A for further
details.

Figure B-1 Lodestar Reference Frame

@ Y Axis Positive (+) Starboard € X Axis Positive (+) Forward
@) Orientation Marks (Forward) ¢) Z Axis Positive (+) Down

B.2 Vehicle Reference Frame

For most applications, measurements are required with respect to the vehicle’s reference frame.
The definition of the vehicle reference frame is shown below.

Unless otherwise stated for a particular output telegram, the Lodestar will output measurements with
respect to this frame.

Before installing the Lodestar it is important to understand the concept of the vehicle reference
frame. Often the chosen centre of a vehicle’s reference frame is its centre of motion or mass and is
usually defined and documented prior to the installation of equipment such as the Lodestar. The
centre of the vehicle’s reference frame is often referred to as the CRP or central reference point.

Appendix B — Reference Frames and Angular Conventions 103



UM-8253
Issue A Rev 4

User Manual for SPRINT

In a typical installation, the Lodestar may not be perfectly aligned to the installation vehicle
reference frame.

Figure B-2 Vehicle Reference Frame

@ Positive Pitch (Bow up) ¢ Down (2
@ Starboard (Y) © Positive Roll (Starboard Down)
€ Positive Heading Change ( Forward (X)

B.3 Mounting Angles

In some cases, for the Lodestar to output measurements that are correct for the vehicle reference
frame, mounting angles in the three axes must be carefully measured and configured.

The rotation sequence from a reference frame (vehicle) to the actual Lodestar frame is:
1. Rotation by the C (Heading) angle about the Z axis of the reference frame.
2. Rotation by the B (Pitch) angle about the resulting Y axis.
3. Rotation by the A (Roll) angle about the resulting X axis.

Note

Only the misalignment for angle C (heading) can be measured independently. The misalignments
for angles B (pitch) and A (roll) are the resultant misalignments after the preceding misalignments
have been applied.

Mounting angles are specified as Euler angles; see Appendix A for further details.
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The convention for measuring each mounting angle is shown below.

Note

To simplify the definition and convention of each mounting angle, each angle is depicted

independently but in practice they are non-commutative and must be measured in the order defined
previously.

Figure 14-1 Lodestar Heading Mounting Angle Example

@ Heading Output (Mounting Angle +40°) € Heading Output (Mounting Angle 0°)
@) Positive (+) Mounting Angle Applied

Figure B-3 Lodestar Pitch Mounting Angle Example

@ Pitch Output (Mounting Angle 0°) € Pitch Output (Mounting Angle +30°)
@) Positive (+) Mounting Angle Applied
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Figure B-4 Lodestar Roll Mounting Angle Example *

@ Roll Output (Mounting Angle 0°) € Roll Output (Mounting Angle +30°)
@) Positive (+) Mounting Angle Applied

*Vehicle view is bow-on.
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Appendix C — Lodestar Mounting Angle Examples

C.1.1 Lodestar Mounting Angle Examples

This section provides some examples of alternate Lodestar mountings and the associated “coarse”
mounting angles that should be used in the system configuration.

Configuration A

If the Lodestar is mounted in the following configuration:

Then use the following mounting angles on the Lodestar configuration page:

Heading: 0
Resulting Pitch: 90
Resulting Roll: 0

Configuration B

If the Lodestar is mounted in the following configuration:

Then use the following mounting angles on the Lodestar configuration page:

Heading: 180
Resulting Pitch: -90
Resulting Roll: 0
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Configuration C

If the Lodestar is mounted in the following configuration:

Then use the following mounting angles on the Lodestar configuration page:

Heading: 0
Resulting Pitch: -90
Resulting Roll: 0

Configuration D

If the Lodestar is mounted in the following configuration:

Then use the following mounting angles on the Lodestar configuration page:
Heading: 180

Resulting Pitch: 90

Resulting Roll: 0

Appendix C — Lodestar Mounting Angle Examples

108



UM-8253
Issue A Rev 4

User Manual for SPRINT

Appendix D — Recommended DVL Configurations

D.1.1 Recommended DVL Configuration

Please contact Sonardyne Support if your DVL configuration is not listed (e.g. PDO).

D.1.2 RDIDVL PDA4/5 (Triggered)

e CR1

e C(CB811

e CF11110
e CX1

e CT1

e BKO

e EXO01010

e EZ0000001
e PD4 (or PD5)
e TEO00:00:00.00

e TP00:00.00
e CK
e CS

D.1.3 RDI DVL PD4/5 (Non-Triggered)

e CRI1

e C(CB811

e CF11110
e CXO

e CT1

e BKO

e EXO01010

e EZ0000001
e PD4 (or PD5)
e  TE00:00:00.00

e TP00:00.00
e CK
e CS
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Appendix E — Sprint Message Definitions

E.1 Introduction

This section lists messages that are specific to the SPRINT (INS) system input and output. Other
messages are available for output, such as Lodestar AHRS output messages. These are listed
manual 8084-109 AHRS Messages.

Table E-1 SPRINT Input & Output Messages

Message INS Input INS Output
GG é GG Y
A PGGA
NPGGA INGGA
PSIMSSB v x
Sonardyne External Position v x
DVL PD4 v x
DVL PD5 v x
DigiQuartz Pressure Depth v x
Valeport Midas SVX2 Depth v x
PSONDEP Depth v x
NMEA DPT Depth v x
Sonardyne External Depth v x
ZDA v x
Valeport Sound Velocity v x
PSONSS Sound Velocity v x
INS Navigation x v
INS Navigation Quality x v
Time System x v
Sonardyne PSONNAV x v
Sonardyne LNAV x v
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E.2 Simrad SSB — SSBL Position Report ($PSIMSSB)
Reference: Kongsberg APOS Release 4.2.2 Manual (29.April. 2005)

E.2.1 Description

The PSIMSSB sentence contains the position of a SSBL beacon which is sent after each USBL
measurement. The operator may define various parameters.

E.2.2 Format

$PSIMSSB,hhmmss.ss,ccc,a,ccc,a,a,a,X. X, X.X,X.X,X.X,a,X.X,X.x*hh <cr><If>
Table E-2 PSIMSSB Formatting

Field Description

$ Start character

PSIM Proprietary Simrad code

SSB Sentence Formatter

hhmmss.ss Empty or UTC time of reception

cce Beacon code, Examples: BO1, B33, B47

a Status, A for OK, V for not OK

cce Error_code, Empty or 3 character error code

a C for Cartesian, P for polar, U for UTM coordinates, R for radians

a Orientation, H vessel head up; N for north; E for East:

a Software filter, M=Measured, F=Filtered, P=Predicted

X.X x coordinate

X.X y coordinate

X.X Depth in metres

X.X Expected accuracy of the position

a Additional i_nfo, N=none,C= compass, I=inclinometer, T=Time from Beacon
to Transceiver

X.X First add value, empty or Tp compass or Tp x inclination

X.X Second add value, empty or Tp y inclination.

*hh Terminator and checksum (or empty?)

<cr><If> return plus linefeed
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E.2.3 Supported Input Format
Sonardyne Marksman/Ranger 2 and Kongsberg HiPAP:

‘ Beacon ID H WGS 84 Lat/Long ‘
4t

——_n-_l__,I?-
$PSINISSE,091430.22B18)A (R,N,M1.28,1.8 ,131.88N,,*7E
MUST be UTC || MUST be: USBL Quality
R = Radians,

N = North Orientation,
M = Measured

E.3 Proprietary $PSONDEP Report

E.3.1 Description

The purpose of this proprietary string is to support depth input into Sonardyne software and
instruments from a non-specific source. This string is already used in several subsea positioning
applications with both Ranger and Fusion software.

E.3.2 Format

$PSONDEP,x.xx,y.y,c*hh<cr><If>
Table E-3 PSONDEP Formatting

Field Description

$ Start_character
PSONDEP Address

X.XX Depth

y.y Observation Error

c Units (M=metres)

*hh Terminator and Checksum
<cr><If> Termination (0xOD 0x0A)

E.3.3 Supported Input Format

$PSONDEP,1A

Measurement Data
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E.4 Proprietary $SPSONSS Report

E.4.1 Description

The purpose of this proprietary string is to support sound speed input into Sonardyne software and
instruments from a non-specific source. This string is already used in several subsea positioning
applications with both Ranger and Fusion software.

E.4.2 Format

$PSONSS, x.x,y.y,c*hh<cr><If>
Table E-4 PSONSS Formatting

Field Description

$ Start_character

PSONSS Address

X.X Depth

y.y Sound Speed in Units per second
c Units

*hh Terminator and Checksum
<cr><If> Termination (0xOD 0x0A)

E.4.3 Supported Input Format

$PSONSS,2011.00,1500.00,M*65
==

Sound Velocity

E.5 Digiquartz Pressure Sensor Report

E.5.1 Description

Pressure depth output from Paroscientific Digiquartz intelligent pressure depth sensor.

E.5.2 Format

*0001nnn__ <cr><If>
Table E-5 Digiquartz Formatting

Field Description

* Start character

00 Destination ID (00 is ID of serial host)

01 Source ID (01 is ID of sender device)

nnn__ Measurement Data (units=Metres H20 / KPA / PSI)
<cr><If> return plus linefeed
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E.5.3 Supported Input Format

*000195.247173

Measurement Data

E.6 $ DPT Report

E.6.1 Description
This is NMEA string outputs water depth.

E.6.2 Format

$_ DPT x.x,y.y,z.z*hh<cr><If>
Table E-6 DPT Formatting

Field Description

$ Start_character

__DPT Address

X.X Water depth relative to the transducer, in metres
y.y Offset from transducer, in metres. (NOT USED)
z.z Maximum range scale in use

*hh Terminator and Checksum

<cr><If> Termination (0xOD 0x0A)

E.6.3 Supported Input Format
$SDDPT,20.3,0.0,0.064
==

Measurement Data

E.7 Valeport Sensor Telegram

E.7.1 Description

This simple string outputs the data from the Valeport Mini SVS sensor. Sound Velocity only m/sec
supported.
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E.7.2 Format

<space>XxXxXx.xxx<cr><|f>
Table E-7 Valeport Sensor Telegram Formatting

Field Description

<space> A space character

XXXX. XXX Sound Speed in metres per second
<cr><If> Termination (0xOD 0x0A)

E.7.3 Supported Input Format

‘ 1 or 2 leading spaces ‘
‘ﬂ__?

Sound Velocity

E.8 $ GGA Report

E.8.1 Description
This NMEA string outputs longitude and latitude at a UTC time.
E.8.2 Format

$--GGA, hhmmss.ss,llILILa,yyyyy.yy,a,x,xx,X. X, X.XxX, M, X.X, M,X.X,xxxx*hh<cr><If>
Table E-8 GGA Formatting

Field Description

$ Start character

- Sender Code (IN ? or GP)
GGA Sentence Formatter
hhmmss.ss uTC

Latitude, N/S 2 fixed digits degrees, 2 fixed digits minutes, variable digits of

lil.1l.a decimal minutes.
a Longitude, E/W 3 fixed digits degrees, 2 fixed digits minutes, variable digits
YYYYY-YY: of decimal minutes.
X GPS quality Indicator 0-8
XX Number of satellites
X.X Horizontal dilution of precision
Antenna altitude above/below mean sea level (geoid), Metres (units of
X.XXX,M .
antenna altitude)
X.X,M Geoidal Separation, Metres
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Field Description

X.X Age of Differential data, not relevant.
XXXX Differential Reference Station 1D
*hh Terminator and checksum

<cr><If> Terminator, return plus linefeed

E.8.3 Supported Input Formats

Sonardyne Ranger:

$GPGGA(145750.00 4459.97858,N,00600.06971 ,07,1.4,0.000,M,0.0,M,2.250

MUST be UTC MUST be WGS 84 Lat/Long Beacon ID

EIVA NaviPac:
$NPGGA145750.00,4459.97858,N,00600.06971,E. ,07,.000,M,0.0,M,2.2,0362*50
| Tt

MUST be UTC || MUST be WGS 84 Lat/Long USBL Quality

E.9 $ ZDA Report

E.9.1 Description
This NMEA string outputs UTC,day,month,year and local time zone.

E.9.2 Format

$--ZDA,hhmmss.SSS, XX, XX, XXXX,XX,XxX*hh <cr><If>
Table E-9 ZDA Formatting

Field Description

$ Start character

-- Sender Code

ZDA Sentence Formatter
hhmmss.sss Hours, minutes, seconds, and decimal seconds
XX Day, 0 to 31

XX Month, 01 to 12

XXXX Year

XX Local Zone hours 00 to +13
XX Local Zone minutes 00 to 59
*hh Terminator and checksum
<cr><If> return plus linefeed
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E.9.3 Supported Input Format

$GPZDA,162408.00,02,04,2007,,"6C

MUST be UTC

E.10 Navigation (Nav) Data

The navigation (Nav) data message is the generic navigation output from Lodestar AINS and is
closely related the navigation quality message (NavQual); see Table E-10.

Note

Nav and NavQual are intended for advanced users including internal (Sonardyne) and external
system integrators. Nav values are valid for vehicle CRP / frame, except acceleration which is valid for
the IMU zero point but expressed in vehicle frame. For best accuracy it is recommended to use
CRP=IMU zero point. AINS algorithm is the only source for the NAV message.

Table E-10 Navigation Data

Byte# Field Unit (LSB) Data Note
name type
0-5/6 timeTag |le-6 sec Uint48 | System time
6-9/4 lat 2"-31*90 x° [-90;90] Int32 | +North (LSB ~= 0.5cm)
10-13/4 |lon 27-31*180° [-180; 180] |Int32 |+East (LSB ~= 1cm @ Equator)
14-17 /4 |depth le-3m Int32
18-19/2 |altitude le-2m Uintl6 |Height above seabed (from DVL)
20-21/2 |roll 27-15*180° [-180; 180] |Intl6 |Angle between y and horizontal. Roll is

positive when vy is pointed below the
horizontal (starboard down)

22-23/ 2 |pitch 27-15*180° [-90;90] Int16 |Angle between x and horizontal. Pitch is
positive when x is pointed above the
horizontal (bow up)

24-25/2 |heading |27-15*180° [0;360] Uintl6 |Angle between North and projection of
X onto the horizontal (measured about
down).

26-27 /2 |vx le-3m/s Intl6 | X-velocity (max ~32m/s)

28-29/2 |vy - - -

30-31/2 |vz - - -

32-33/2 |wx le-2°/s Intl6 | Angular rate about x axis (max ~327°/s)

34-35/2 |wy - - -

36-37/2 |wz - - -

38-39/2 |ax le-3 m/s”2 Intl6 | X-acceleration (max ~ 3.2 G)

40-41/2 |ay - -

42-43 /2 |az - -
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Byte#

Field
name

Unit (LSB)

Data
type

Note

44-45/ 2

mode

N/A

Bit16

Logical. Bit#

0: data valid

1L:INS initialised

2: INS application not enable
3-14: Reserved

15: System failure

Note

Altitude = 0 imply invalid.

E.11 Navigation Quality Estimate (NavQual)

The navigation quality message reports the expected accuracy of the data given in the “nav”

message.

Notes

Horizontal position 1DRMS = sqrt(posMajor*2 + posMinor”2).

CEP(50%) ~= 0.589 * (posMajor + posMinor).

Error ellipse (1 sigma) is 39.4% probability (i.e. 39.4% likelihood that true value is within ellipse).

95% percent probability error ellipse is 2.447 * 1 sigma error ellipse.

Roll, pitch 1 sigma ~= max(stdLevN,stdLevE) for roll, pitch << 45deg.

Velocity rms = sqgrt(velMajor*2+ velMinor”2).

Table E-11 Navigation Quality Estimate — Rate: 1 Hz

Byte# Field name Unit (LSB) / range geg: Note
0-5/6 |timeTag le-6 sec Uint48 |System time

i , Position (horizontal) error ellipse:
6-9/4 | posMajor m Float32 | semi-major axis (1 sigma)
10-13/ 4 |posMinor - Float32 |- semi-minor axis (1 sigma)
14-17 / 4 |dirPMajor deg [0;360][ Float32 | - direction of semi-major axis
18-21/ 4 |stdDepth m Float32 | Depth (1 sigma)
22-25/ 4 |stdLevN deg Float32 | Level error about North (1 sigma)
26-29 / 4 |stdLevE deg Float32 | Level error about East (1 sigma)
30-33/ 4 |stdHeading deg Float32 | Heading (1 sigma)

) : Velocity (horizontal) error ellipse: -

34-37 | 4 |velMajor m/s Float32 semi-major axis (1 sigma)
38-41/ 4 |velMinor m/s Float32 |- semi-minor axis (1 sigma)
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Byte# Field name Unit (LSB) / range geg: Note
42-45 [ 4 |dirVMajor deg [0;360][ Float32 | - direction of semi-major axis
46-49 / 4 |velDown m/s Float32 | Down velocity (1 sigma)

E.12 Time System Data

The Time System data format is defined below.

Notes

Source of RTC to UTC update; 0 = NO SOURCE; 1 = LODESTAR RTC; 2 = Standalone GPZDA; 3 =
Standalone GPGGA; 4 = GPZDA 1PPS.

Fields in italic are for advanced users only and are subject to change.

Table E-12 Time System Data

Field# |Byte# Size Field name Unit/LSB Data type | Notes
(from 0) |(bytes)
1 0-5 6 sysTime le-6 sec |Uint48 System time (and
message timeTag)
2 6-13 8 utcTime le-6 sec |Uint64 UTC time — seconds since
midnight 1970.01.01
3 14-19 6 timeSinceUpdate |le-6sec |Uint48 |Time since last accepted

UTC time update, e.g.
from ZDA/PPS

4 20-23 4 stdDev sec Float32 |Expected standard
deviation of UTC time field

5 24 1 Source logical Uint8 Currently used source of
UTC sync

6 25 1 ppsRising logical Uint8 0: PPS valid on falling
edge

(low to high voltage).
1: PPS valid on rising

edge.

7 26 1 zdaCount # Uint8 LS byte of ZDA message
count

8 27 1 ppsCount # Uint8 LS byte of PPS message
count

9 28 1 zdaRejCount # Uint8 LS byte of ZDA message
rejection count

10 29 1 ppsRejCount # Uint8 LS byte of PPS signal
rejection count

11 30 1 ppsZdaProcCount |# Uint8 LS byte of accepted
PPS/ZDA pairs
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Field# |Byte# Size Field name Unit/LSB Data type |Notes
(from 0) |(bytes)
12 31 1 filtResetCount # Uint8 LS byte of UTC filter reset
count

Example: Converting IMU time tag from [sys] to [utc]

imu.timeTag[sys] = 1234567890 usec

Get the preceding time system message:

timeSys.sysTime = 1234101010 usec

timeSys.utcTime = 1254273030984001 usec

timeSys.stdDev = 0.0000124 sec low std.dev. => UTC can be trusted
imu.timeTag [utc] = imu.timeTag[sys] + (timeSys.utcTime - timeSys.sysTime)

= 1234567890 + (1254273030984001 - 1234101010) usec

= 1254273031450881 usec = 20090930T011031 (ISO 8601) = 2009-09-30 01:10:31

E.13 Midas SVX2 Depth

E.13.1 Description

This message is tab delimited and provides Sound Velocity, Depth, Temperature and conductivity.

E.13.2 Format

ssss.sss<tab>uuuu<tab>dddd.ddd<tab>xxxx<tab>tttt.ttt<tab>xxxx<tab>cccc.ccc<tab>zzzz<cr><If>

Table E-13 Navigation Data

Field Description

$SSS.SSS Sound Velocity in metres per second
uuuu Sound Velocity Units (M/SEC)
dddd.ddd Depth

XXXX Depth Units (DBAR)

tett.ttt Temperature

XXXX Temperature Units (C)

ccece.ccc Conductivity

7777 Conductivity Units (MS/CM)

<cr><|f> return plus linefeed
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E.13.3 Supported Input Format

Tab
Delimited

\

1483.576 H/SEC 0021.291 C 0000.142 MS/CM

Depth Depth
Measurement Units

E.14 Proprietary XPOS Report

E.14.1 Description

This proprietary message provides an external position and depth.

E.14.2 Format
$XPOS,hhmmss.sss,llILINILa,yyyyy.yyyyyy,a,x.xxx,x.xxx,x.xxx,d.ddd,d.ddd,aa*hh<cr><If>

Table E-14 XPOS Formatting

Field Description Units
$XPOS Start Character n/a
hhmmess.sss uTC
Latitude: 2 fixed digits degrees, 2 fixed digits
memm minutes, minimum 6 digits of decimal minutes Degrees [0;90]
(2mm resolution or better).
a N/S
IV SISy minutes, minmm 6 dighs of decimal minuias, | Degrees [0:180]
a E/W
X XXX posMajor — if not used then field will be null Metres
X XXX posMinor — if not used then field will be null Metres
X XXX dirPMajor — if not used then field will be null Degrees
d.ddd Depth — if not used then field will be Null Metres
d.ddd stdDepth — if not used then field will be Null Metres
aa Spare* n/a
*hh Terminator and Checksum
<cr><If> Carrier return and line feed
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E.14.3 Supported Input Format

E.15 Proprietary XDepth Report

E.15.1 Description

This purpose of this string is to support an external depth input into Sonardyne software and
instruments from a non-specific source.

E.15.2 Format
$XDEPTH, hhmmss.sss,d.ddd,x.xxx,aa*hh<cr><I|f>

Table E-15 XDepth Formatting

Field Description

$XDEPTH Start Character

hhmmss.sss uTC...

d.ddd Depth in metres

X. XXX Depth Standard Deviation in metres
aa Spare

<cr><If> return plus linefeed

E.15.3 Supported Input Format

E.16 Proprietary PSONNAV

E.16.1 Description

The purpose of this proprietary message provides output navigation which consists of a UTC
timestamp, position, depth, velocity, attitude and heading with associated accuracy estimates.
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E.16.2 Format

$PSONNAV, hhmmss.sss, LI a,yyyyy.yyyyyy,a,x.Xxx,X.XXX,X.xxx,a,d.ddd,x.xxx,r.rrr,p.ppp,h.hhh x.
XXX,a,aaaaaaa, , , , , ,*hh<cr><If>

Table E-16 Digiquartz Formatting

Field Description

& Start character

PSONNAV Address

hhmmss.sss UTC Timestamp

He,a Latitude

YYYYY.YYYYYY,a Longitude

X XXX Major Axis position error ellipse
X.XXX Minor Axis position error ellipse
X.XXX Direction of major Axis position error ellipse
a Position Status

d.ddd Depth

X.XXX Depth standard deviation

r.rer Roll

p.ppp Pitch

h.hhh heading

X XXX Heading standard deviation

a Orientation status

aaaaaaa Sensor status

e Null fields for future use
<cr><If> return plus linefeed

A.1.1. Supported Input Format

$PSONNAV,153239.443,5119.838453,N,00050.141452,W,0.155,0.155,1.861,A,-
0.040,0.218,0.798,0.079,279.846,0.133,A Al,,,,,,*46<cr><If>
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E.17 LNav

E.17.1 Description

This proprietary data message is the generic navigation output from Lodestar INS / AHRS, which is
essentially the combination of the Nav and NavQual message.

Table E-17 LNav Data

Byte# Size Field name Optional |Datatype |Notes
(from 0) |(bytes) Units
1-6 6 Time Tag 10° seconds |No Uint48 System time
6-10 4 Latitude 2%'x90deg |Yes, see |Int32 Latitude, Note 1
Note 11
11-14 |4 Longitude 2%'x180 deg |Yes, see |Int32 Longitude, Note 2
Note 11
15-18 4 Depth 10 metres Yes, see |[Int32 Depth below sea level,
Note 11 Note 3
19-20 |2 Altitude 10?2 metres | Yes, see |Uint16 Height above seabed,
Note 11 Note 4
21-22 |2 Roll 2°x180 deg |No Int16 Note 5
23-24 |2 Pitch 2°x180 deg |No Int16 Note 6
25-26 |2 Heading 2°x180 deg |No Uint16 Note 7
27-28 2 yFwd 10° m/s Yes, see |Intl6 Vehicle Fwd-velocity
Note 11
29-30 |2 yStbd 10° m/s Yes, see |Intl6 Vehicle Stbd-velocity
Note 11
31-32 2 yDwn 10° m/s Yes, see |Intl6 Vehicle Dwn-velocity
Note 11
33-34 2 wFwd 10 deg/s No Int16 Angular rate about
Vehicle Fwd axis
35-36 |2 wSthd 10 deg/s No Int16 Angular rate about
Vehicle Sthd axis
37-38 2 wDwn 102 deg/s No Int16 Angular rate about
Vehicle Dwn axis
39-40 |2 aFwd 10" m/s? No Int16 Vehicle Fwd-
acceleration
41-42 |2 aStbd 10 m/s? No Int16 Vehicle Sthd-
acceleration
43-44 |2 aDwn 10° m/s® No Int16 Vehicle Dwn-
acceleration
45-48 |4 posMajor Metres Yes, see |Float32 |Horizontal position 10
Note 11 error ellipse (Note 8):
- semi-major axis
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Byte# Size Field name Optional |Datatype |Notes

(from 0) |(bytes) Units

49-52 |4 posMinor Metres Yes, see |Float32 |- semi-minor axis
Note 11

53-56 |4 dirPMajor Degrees Yes, see |Float32 |- direction of semi-
Note 11 major axis

57-60 |4 stdDepth Metres Yes, see |Float32 |10 depth error
Note 11

61-64 4 stdLevN Degrees Yes, see |Float32 10 level error about
Note 11 North (Note 9)

65-68 |4 stdLevE Degrees Yes, see |Float32 |10 level error about
Note 11 East (Note 9)

69-72 |4 stdHeading Degrees Yes, see |Float32 |10 heading error
Note 11

73-76 |4 velMajor m/s Yes, see |Float32 |Horizontal velocity 10
Note 11 error ellipse (Note 10):

- semi-major axis

77-80 4 velMinor m/s Yes, see |Float32 - semi-minor axis
Note 11

81-84 |4 dirVMajor Degrees Yes, see |Float32 |- direction of semi-
Note 11 major axis

85-88 4 velDown m/s Yes, see |Float32 10 down velocity error
Note 11

89-90 |2 Status N/A No Bit16 Note 12

Note 1 — Latitude, north is positive. 0.5 cm resolution.
Note 2 — Longitude, east is positive. 1 cm resolution at equator.
Note 3 — Depth, down is positive.

Note 4 — Height above seabed as measured by the DVL, contains the last valid altitude received
from the DVL.

Note 5 — Roll is the angle between the Stbd-axis and horizontal. Roll is positive when Stbd is
pointed below the horizontal (starboard down).

Note 6 — Pitch is the angle between the Fwd-axis and horizontal. Pitch is positive when Fwd is
pointed above the horizontal (bow up).

Note 7 — Heading is the angle between North and projection of the Fwd-axis onto the horizontal
(measured about the down direction).

Note 8 —
e Horizontal position 1IDRMS = sqrt(posMajor*2 + posMinor”"2)
e CEP(50%) ~= 0.589 x (posMajor + posMinor)

e Error ellipse (10) is 39.4% probability (i.e. 39.4% likelihood that true value is within
ellipse)

e  95% percent probability error ellipse is 2.447 x 1o error ellipse

Appendix E — Sprint Message Definitions 125



User Manual for SPRINT

UM-8253
Issue A Rev 4

Note 9 — Roll & pitch 10 ~= max(stdLevN,stdLevE) for roll, pitch << 45 deg.
Note 10 — Velocity RMS = sqgrt(velMajor2+ velMinor~2)
Note 11 — Will be populated with zero values if data unavailable (e.g. INS is not initialised / DVL

data invalid)

Note 12 - The status bits are described below (if bit = 0 then status is OK):
Table E-18 LNav Status

Status Bit Field name Notes/Bit Set

0 bOrientationStatus Orientation Invalid (e.g. AHRS not OK or unsettled)

1 bPosStatus Position (& Velocity) Invalid (e.g. INS not OK or not
initialised)

2 bAltitudeStatus 0 indicates that the altitude field has been updated
in this message compared to the last time the
LNAV message was sent. 1 indicates that the
altitude data is either old (no update from DVL
since last LNAV message sent) or invalid.

4 bOrientationSource 0 indicates Orientation source = AHRS, 1 indicates
Orientation source = INS

5 bSubseaUSBLUsed 0 indicates data received and some or all used
within the last second, otherwise 1

6 bDepthUsed 0 indicates data received and some or all used
within the last second, otherwise 1

7 bDVLUsed 0 indicates data received and some or all used
within the last second, otherwise 1

8 bLBLUsed 0 indicates data received and some or all used
within the last second, otherwise 1

9 bZUPTUsed 0 indicates data received and some or all used
within the last second, otherwise 1

10 bXPOSUsed 0 indicates data received and some or all used
within the last second, otherwise 1

11 bGPSUsed 0 indicates data received and some or all used
within the last second, otherwise 1

12 bZMDUsed 0 indicates data received and some or all used
within the last second, otherwise 1

13 bUSBLUsed 0 indicates data received and some or all used
within the last second, otherwise 1

14-15 Not Used Reserved for future use
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Appendix F — SPRINT Wiring Diagram
F.1 Typical Wiring Diagram

Figure F-1 Typical SPRINT Wiring Diagram
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Appendix G — Pressure to Depth Conversion

Pascal to Metres: 0.00009938710
PSI to Pascals: 6894.757293168361
Metres to PSI: 0.7030696
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Appendix H — SPRINT Install & Setup Checklist

Post-Transit Checks Yes | No Notes

Prior to installation on the vehicle has the Lodestar been powered and
connected to the SPRINT topside (PC & LCH) to check operation and
basic communication?

Vehicle Checks Yes | No Notes
Vehicle | Vehicle CRP defined and identifiable?

Is Lodestar mounted rigidly and away from any source of vibration or (non-
vehicle frame) independent movement?

[Serial] Vehicle MUX connection configured/available @ 115,200 baud
rate?

[Ethernet] Vehicle MUX connection configured/available @ 100 Mbit?

Cable connection wired as per system wiring diagram?

[Serial] 232/485 select pin wired correctly?
Powered by either 24 or 48 V?

Offsets from vehicle CRP to Lodestar 'Centre of Axis' measured (Metres)?

Forward:
Starboard:

Down:

1000 m Rated Lodestar:

3000 m Rated Lodestar:

5000 m Rated Lodestar:
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Mounting Angles from vehicle frame to Lodestar frame measured
(Degrees)?NB: Not required if Lodestar mounted nominally: Connectors
are uppermost on Lodestar and 'X' orientation mark is aligned with forward

direction of vehicle body Heading:
Pitch:
Roll:
Offsets from vehicle CRP to USBL beacon (centre of transducer)
USBL
measured (Metres)? Forward:
Starboard:
Down:
If multiple USBL beacons present, has acoustic check been run on the
SPRINT aiding beacon to confirm correct address and offsets?
If SPRINT aiding beacon is responder, has responder trigger been
checked?
Offsets from vehicle CRP to depth sensor (point of measurement)
Depth
measured (Metres)? Forward:
Starboard:
Down:
Cable connection wired as per system wiring diagram?
Sensor powered?
If multiple depth sensors present, has check been run on the SPRINT
aiding sensor to confirm correct offsets?
Has output format been checked (for compatibility) prior to connection with
Lodestar or SPRINT? Eormat:
units:
Have serial settings been checked? Baud Rate:
Data Bits:
Stop Bits:
Parity:
LBL Offsets from vehicle CRP to the LBL Transducer measured (Metres)? Eorward:
Starboard:
Down:
Cable connection wired as per system wiring diagram?
Sensor powered?
If LBL transducers present, has check been run on the SPRINT aiding
sensor to confirm correct offsets?
DVL Offsets from vehicle CRP to DVL (centre of transducer faces) measured
(Metres)? Forward:
Starboard:
Down:
Cable connection wired as per system wiring diagram?
DVL facing down with alignment mark facing forward on the vehicle?
NB: Misalignments can be calculated by the DVL calibration procedure
Is DVL triggered by Lodestar? (If no then DVL will be free-running /
untriggered)
DVL powered?
If multiple DVLs present, has check been run on the SPRINT aiding DVLto
confirm correct offsets?
Can DVL be auto-configured by SPRINT (customer does have a specific
output requirement?)
If No:
e Has configuration been checked (for compatibility) prior to
connection with Lodestar? Format:
Units:
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e Have serial settings been checked? Baud Rate:
Data Bits:
Stop Bits:
Parity:
Remote | s position output from SPRINT required from a point other than the vehicle
Output | crp?
Points
If Yes:
Offsets from vehicle CRP to remote point(s) measured (Metres)? Forward:
Starboard:
Down:
Topside Checks Yes | No Notes
LCH Is LCH powered?
Is LCH connected to the SPRINT PC?
Can the LCH Admin Page be opened?
Lodestar | [Serial] Is Lodestar connected to serial port 1 on the LCH?
[Ethernet] Is Lodestar connected to Ethernet port 2 on the LCH?
Has the default/work site Latitude been set in the SPRINT software
(Lodestar)?
Has the Lodestar shutdown delay been checked in the SPRINT Software
(Lodestar)?
Have the Lodestar offsets been configured in the SPRINT Software
(Lodestar)?
Have the Lodestar mounting angles been configured in the SPRINT
Software (Lodestar)?
Time Has output format been checked (for compatibility) prior to connection with Eormat
Synch | SPRINT? (GPZDA):
Have serial settings been checked? Baud Rate:
Data Bits:
Stop Bits:
Parity:
Has the LCH ZDA serial port been checked/configured with the correct
serial settings?
Is GPZDA output @ 1Hz?
Does GPZDA message contain UTC time and date?
Is the latency between the GPZDA and the actual UTC time known?
Has the Time Synch been configured in the SPRINT software (Time
Synch)?
Has output format been checked (for compatibility) prior to connection with
USBL
SPRINT? Format:
Have serial settings been checked? Baud Rate:
Data Bits:
Stop Bits:
Parity:

Has the LCH USBL serial port been checked/configured with the correct
serial settings?

Is USBL position in WGS84 Latitude Longitude?

Is the USBL position the 'raw' USBL position and not corrected for offsets
or filtered/smoothed?

Does USBL message contain UTC timestamp?

Does USBL message contain USBL quality?
NB: Quality field in PSIMSSB message or in certain applications HDOP
field in USBL GGA message is populated with USBL quality

If No:
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Has the manual USBL quality value been configured in the SPRINT
Software (USBL Input)?

Does USBL feed contain messages for multiple beacons identified by
beacon ID?

NB: Beacon ID field in PSIMSSB message or in certain applications
reference station ID in USBL GGA message is populated with beacon ID

If Yes:

Has the USBL beacon ID filter been configured in the SPRINT Software
(USBL Input)?

Have the USBL beacon offsets been configured in the SPRINT Software
(USBL Input)?

Has the USBL type been configured in the SPRINT Software (USBL
Input)?

Has output format been checked (for compatibility) prior to connection with

Depth || odestar or SPRINT? Format:

Units:

If Depth sensor feed is connected to Topside (not Lodestar):

Have serial settings been checked? Baud Rate:
Data Bits:
Stop Bits:
Parity:

Has the LCH USBL serial port been checked/configured with the correct

serial settings?

Has the correct port been specified and configured if depth sensor is

connected directly to the Lodestar?

Does a surface correction need to be applied?

Have the depth sensor offsets been configured in the SPRINT Software

(Depth Input)?

Has the Depth type and units been configured in the SPRINT Software

(Depth Input)?

DVL Has the correct Lodestar port been specified in the SPRINT software (DVL)

Has the DVL been auto-configured by the SPRINT software?

Yes

Has the DVL been 'deployed' after the auto-configuration?

No

Have the Lodestar port settings been configured to match the DVL serial

settings?

Has the correct 'triggered by Lodestar' setting been configured in the

SPRINT Software (DVL)

Has the correct 'Binary or Hex ASCII' setting been configured in the

SPRINT Software (DVL)

If a new installation, have the default DVL mounting angles been

configured in the SPRINT software (DVL) Heading: 135
Pitch: 0.0
Roll: -179.9

If a new installation have the latency and scale factor values been set to

zero (default) in the SPRINT software (DVL)

Have the DVL offsets been configured in the SPRINT Software (DVL)?

Has the correct Sound Velocity type been specified in the SPRINT software

Sound (Sound Velocity)?
Velocity - -

Yes (automatic DVL derived to be used)

Has the salinity value been checked/set in the SPRINT software (Sound

Velocity)?

Yes (Manual)
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Has the manual sound velocity be set in the SPRINT software (Sound
Velocity)?

Yes (Sound velocity message feed to be used)

Has input format been checked (for compatibility) prior to connection with

SPRINT? Format:
Have serial settings been checked? Baud Rate:
Data Bits:
Stop Bits:
Parity:
Has the LCH serial port been checked/configured with the correct serial
settings?
Sound Velocity sensor offsets are optional - have they been configured in
the SPRINT Software (Sound Velocity)?
LBL Have the serial settings for the INS port been checked in the Fusion
software? Baud Rate:
Data Bits:
Stop Bits:
Parity:
Have the serial settings for the Fusion INS port been checked in the
SPRINT software? As above
Have the serial settings for the LBL port been checked in the Fusion
software? Baud Rate:
Data Bits:
Stop Bits:
Parity:
Have the serial settings for the Fusion LBL port been checked in the
SPRINT software? As above
Have the LBL transceiver AND Lodestar offsets been configured in the
Fusion Software?
Has the transceiver Comms Reset been set to "None" in the Fusion
software (Transceiver Advanced)?
Has the transceiver connection been tested in Fusion (Get or Get All)?
Remote | IS position output from SPRINT required from a point other than vehicle the
output | CRP?
Points If Yes:
Have remote point(s) offsets been configured in the SPRINT software
(Remote Points)?
Outouts Have Lodestar (direct) outputs been configured in the SPRINT software
P (Lodestar Outputs)?
Have PC/LCH outputs been configured in the SPRINT software (PC/LCH
Outputs)?
INS Have the correct INS aiding options been specified in the SPRINT software

(INS Aiding)?
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Definitions
Term Definition
6G® Sonardyne’s sixth generation technology hardware platform.

Attitude and Heading
Reference System (AHRS)

An inertial sensor that provides outputs of heading, pitch and roll.

Attitude and Heading
Reference System (AHRS)

An inertial sensor that provides outputs of heading, pitch and roll.

Doppler Velocity Log (DVL)

A DVL bounces sound off the bottom (or a reference layer of water) and can
determine the velocity vector of a subsea vehicle (or surface vessel) moving
across the sea floor

Global Positioning System
(GPS)

A multi-user, 24-hour, worldwide radio navigation system using the
NAVSTAR constellation of satellites. GPS receivers are capable of tracking
and decoding data from the satellites and using it to compute the position
and velocity of a vehicle.

Inertial Navigation System
(INS)

A navigation aid that uses a computer, motion sensors and rotation sensors
to continuously calculate the position, orientation and velocity of a moving
object without the need for external references.

Long Base Line Positioning
System (LBL)

A system where two or more beacons are on the seabed. The positions of
the beacons are established by a calibration process in a seabed frame. The
distances from a transducer to each beacon are measured using a
transceiver. The position of the transducer can be computed in the seabed
frame. The name comes from the “baselines” joining each beacon.

Sonardyne Sonardyne International Limited and its affiliates.

Sonardyne Wideband®?2 6G® transponders and transceivers use Sonardyne Wideband® 2 ultra-wide
bandwidth signals giving a faster and robust transmission of data, more
precise ranging and mitigation from multipath in shallow water and amongst
steel structures in deep-water.

SPRINT Subsea Precision Reference Inertial Navigation Technology. An Acoustically

aided inertial navigation system for subsea vehicles. The system extends the
operating limits of USBL and improves the operational efficiency of LBL by
using sparse arrays.

Subsea Precision Reference
Inertial Navigation
Technology (SPRINT)

An acoustically aided inertial navigation system for subsea vehicles. The
system extends the operating limits of USBL and improves the operational
efficiency of LBL by using sparse arrays.

Ultra Short Base Line
Positioning System (USBL)

A system similar to an SBL system except the system uses three or more
elements in a single transducer array. The measurements it makes are the
differences in “time-phase” of the signals from each element. The co-ordinate
frame is fixed to the transducer array which must be oriented in the vessel
frame to be equivalent to the SBL.

uTtC Universal Time Co-ordinate. The primary time standard by which the world
regulates clocks and time. Closely related successor to Greenwich Mean
Time (GMT).
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Term Definition

A system similar to an SBL system except the system uses three or more

Ultra Short Base Line e!ements in'a si'ngle transducer array. The measurements it makes are the

Positioning System (USBL) differences in “time-phase” of the signals from each element. The co-ordinate
frame is fixed to the transducer array which must be oriented in the vessel

frame to be equivalent to the SBL.

Definitions 135



User Manual for SPRINT

UM-8253

Issue A Rev 4

Global Headquarters, UK

Blackbushe Business Park
Yateley

Hampshire

GU46 6GD

United Kingdom

T. +44 (0) 1252 872288
F. +44 (0) 1252 876100
sales@sonardyne.com

Houston, USA

8280 Willow Place Drive North
Suite 130

Houston,

Texas

77070 USA

T.+1 281 890 2120

F. +1 281 890 7047

usa.sales@sonardyne.com

Rio das Ostras, Brasil

Av. Zen lotes 05 e 06
Quadra D

Zen, Rio das Ostras — RJ
CEP 28.890-000, Brasil

T. +55 22 2123 4950
F. +55 22 2123 4951
brasil.sales@sonardyne.com

Aberdeen, UK

Units 12-14,

The Technology Centre
Claymore Drive

Bridge of Don, Aberdeen
AB23 8GD UK

T. +44 (0) 1224 707875
F. +44 (0) 1224 707876

sales@sonardyne.com

Singapore, Asia
34 Loyang Crescent
Block B

Singapore

508993

T.+65 6542 1911

F. +65 6542 6937

asia.sales@sonardyne.com

24/7 Emergency Helpline
T. +44 (0) 01252 877600

Email Support
support@sonardyne.com

Website
www.sonardyne.com

Twitter
@sonardyne

Acoustic Positioning @ Inertial Navigation ® Wireless Communication @ Sonar Imaging


mailto:asia.sales@sonardyne.com
mailto:support@sonardyne.com
http://www.sonardyne.com/

	Contents
	Amendment History
	Section 1 – Introduction
	1.1 Introduction
	1.2 Related Publications

	Section 2 – Safety
	2.1 Introduction
	2.2 Safety Procedures
	2.2.1 Warnings
	2.2.2 Cautions


	Section 3 – Technical Description
	3.1 Introduction
	3.2 Lodestar
	3.3 Inertial Navigation
	3.3.1 USBL Aiding
	3.3.2 Sparse LBL Aiding
	3.3.3 ZUPT (Zero Velocity) Aiding
	3.3.4 Vehicle-Mounted Sensor Aiding

	3.4 Theory of Operation
	3.4.1 Inertial Navigation
	3.4.2 Inertial Sensors
	3.4.3 Strap-down Inertial Navigation
	3.4.4 Errors in Inertial Navigation
	3.4.5 Reference frames
	3.4.6 Gyrocompassing – North Finding
	3.4.7 Aided INS

	3.5 System Architecture
	3.5.1 Architecture


	Section 4 – Planning
	4.1 Navigation Scenario
	4.1.1 Construction Survey
	4.1.2 Dynamic Survey

	4.2 Interfaces
	4.3 Connections
	4.4 Cabling
	4.4.1 Topside
	4.4.2 Subsea

	4.5 Time Synchronisation
	4.6 Depth
	4.6.1 Pressure to Depth Conversion
	4.6.2 Surface Pressure
	4.6.3 LBL References

	4.7 (Sparse) LBL Array Planning
	4.7.1 Features and Operational Guidelines
	4.7.2 Sparse Array Geometry
	4.7.3 First Use of ‘Sparse’ LBL Aided INS

	4.8 Check List

	Section 5 – Installation
	5.1 SPRINT System Kit
	5.2 Mounting Lodestar
	5.2.1 Alignment

	5.3 Mounting Aiding Sensors
	5.3.1 Doppler Velocity Log (DVL)

	5.4 Measuring Lever Arms
	5.4.1 Lodestar Lever Arm

	5.5 Connecting the Equipment
	5.6 SPRINT Software
	5.7 Lodestar Firmware
	5.8 Check List

	Section 6 – Configuration
	6.1 Changing the Lodestar Console Port (CP) Baud Rate
	6.2 Configuring Lodestar Communication Hub (LCH)
	6.3 SPRINT Software Configuration
	6.3.1 SPRINT Security Dongle
	6.3.2 Lodestar Connection
	6.3.3 Lodestar Settings
	6.3.4 Lodestar Time Synchronisation
	6.3.5 USBL Aiding
	6.3.6 Depth Aiding
	6.3.7 DVL Aiding
	6.3.8 Sound Velocity
	6.3.9 LBL
	6.3.10 External Position Aiding
	6.3.11 INS
	6.3.12 Options
	6.3.13 Logging
	6.3.14 Remote Output Points
	6.3.15 Lodestar Output
	6.3.16 PC Port Outputs
	6.3.17 View Lever Arms
	6.3.18 View Comms Map
	6.3.19 Main Software Window
	6.3.20 Time Series Plots
	6.3.21 Exporting Configuration and Log Files

	6.4 Check List

	Section 7 – Configuring Acoustic Aiding
	7.1 Configuring Acoustic Aiding from Sonardyne Systems
	7.1.1 Fusion LBL Aiding
	7.1.2 Marksman & Ranger 2 USBL Aiding


	Section 8 – Operation
	8.1 INS
	8.1.1 Initialisation

	8.2 Fusion LBL Aiding
	8.2.1 Transition from USBL to LBL aided INS

	8.3 Zero Velocity (ZUPT) Aiding
	8.3.1 Features and Operational Guidelines
	8.3.2 Enabling Zero Velocity (ZUPT) aiding
	8.3.3 Static Fixes with Zero Velocity (ZUPT) Aiding 
	Pre-Dive Checklist


	Section 9 – Maintenance & Monitoring
	9.1 Monitoring the System
	9.1.1 Main Application Window
	9.1.2 System and Aiding Status
	9.1.3 Navigation Text Panel
	9.1.4 INS Statistics
	9.1.5 INS with Fusion LBL Aiding
	9.1.6 Communications Monitor
	9.1.7 Navigation Quality Limits

	9.2 Maintaining the System
	9.2.1 Logging
	9.2.2 Lodestar Firmware
	9.2.3 SPRINT Security Key Dongle Update


	Section 10 – Functional Test
	10.1 Testing

	Section 11 – DVL Calibration 
	11.1 DVL Calibration Procedure

	Section 12 – Fault Diagnosis
	12.1 Lodestar Connection
	12.2 Attitude Heading Reference System (AHRS)
	12.3 Inertial Navigation System (INS)
	12.4 Time Synchronisation
	12.5 Aiding Inputs (All)
	12.6 USBL Aiding
	12.7 Depth Aiding
	12.8 Doppler Velocity Log (DVL) Aiding
	12.9 LBL Aiding
	12.10  External Position Aiding

	Section 13 – Retrieval and Storage
	13.1 Dismantling
	13.2 Storage

	Section 14 – Spares
	14.1 Introduction
	14.1.1 Component Identification Table


	Appendix A – Lodestar Angle Definitions
	A.1 Euler angles (Tate Bryan Rotations)
	A.1 Heading (Azimuth, Yaw)
	A.2 Pitch 
	A.3 Roll
	A.4 Gravity (Datawell) Angles
	A.5 Pitch
	A.6 Roll
	A.7 Heading

	Appendix B – Reference Frames and Angular Conventions
	B.1 Lodestar Frame
	B.2 Vehicle Reference Frame
	B.3 Mounting Angles

	Appendix C – Lodestar Mounting Angle Examples
	Appendix D – Recommended DVL Configurations
	Appendix E – Sprint Message Definitions
	E.1 Introduction
	E.2 Simrad SSB – SSBL Position Report ($PSIMSSB)
	E.3 Proprietary $PSONDEP Report
	E.4 Proprietary $PSONSS Report
	E.5 Digiquartz Pressure Sensor Report
	E.6 $__DPT Report
	E.7 Valeport Sensor Telegram
	E.8 $__GGA Report
	E.9 $_ZDA Report
	E.10 Navigation (Nav) Data
	E.11 Navigation Quality Estimate (NavQual)
	E.12 Time System Data
	E.13 Midas SVX2 Depth
	E.14 Proprietary XPOS Report
	E.15 Proprietary XDepth Report
	E.16 Proprietary PSONNAV
	E.17 LNav

	Appendix F – SPRINT Wiring Diagram
	F.1 Typical Wiring Diagram

	Appendix G – Pressure to Depth Conversion
	Appendix H – SPRINT Install & Setup Checklist
	Definitions

